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ÖZET 
 
 
 
 

GRAFİK VE ANİMASYON DERSİNDEKİ MOBİL ÖĞRENME 

UYGULAMALARININ ÖĞRENCİLERİN AKADEMİK 

BAŞARILARINA VE MOBİL ÖĞRENMEYE YÖNELİK 

TUTUMLARINA ETKİSİ 
 
 
 

Kadir DEMİR 

 

 

 

Danışman 

Doç. Dr. Ercan AKPINAR 

 
 

      Bu araştırmanın amacı, Bilgisayar ve Öğretim Teknolojileri Öğretmenliği Anabilim 

Dalı’nda okutulan Grafik ve Animasyon dersindeki mobil öğrenme uygulamalarının 

öğrencilerin akademik başarılarına ve mobil öğrenmeye yönelik tutumlarına etkisini 

araştırmaktır. Ayrıca araştırmada, yapılan uygulamanın öğrencilerin animasyon 

geliştirme düzeylerine de etkisi incelenmiştir. Araştırmada yöntem olarak öntest-sontest 

kontrol gruplu yarı deneysel araştırma modeli kullanılmıştır.  Çalışma, 2013-2014 yılı 

bahar döneminde, Dokuz Eylül Üniversitesi Buca Eğitim Fakültesi Bilgisayar ve 

Öğretim Teknolojileri Öğretmenliği bölümünde öğrenim gören ikinci sınıf lisans 

öğrencilerinden 15 kişilik deney ve 26 kişilik kontrol grubu ile gerçekleştirilmiştir.  

 

      Araştırmada veri toplama araçları olarak; Akademik Başarı Testi ve Mobil 

Öğrenmeye Yönelik Tutum Ölçeği ön test ve son test olarak her iki gruba da 

uygulanmıştır.  Ayrıca deney ve kontrol grubu öğrencilerinin öğretim sonunda geliştirmiş 

oldukları animasyonlar toplanmıştır. Başarı testi ve tutum ölçeği SPSS (22,0 sürümü) 

yazılımı yardımıyla çözümlenmiştir. Her iki grubun başarı ve tutum ölçeğinden aldıkları 

puanlar arasında anlamlı bir fark olup olmadığını belirlemek amacıyla bağımsız 
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örneklemler t-testi ve mann-whitney u testi kullanılmıştır. Animasyonlar ise animasyon 

geliştirme düzeyi dereceli puanlama anahtarı kullanılarak değerlendirilmiştir.  

 

      Sonuç olarak; başarı testi ön test sonuçlarına göre deney ve kontrol grupları arasında 

anlamlı bir fark yokken son test sonuçlarına göre ise deney grubu lehine anlamlı bir 

farklılık olduğu görülmüştür. Deney ve kontrol gruplarının ön test-son test mobil 

öğrenmeye yönelik tutum puanları arasında anlamlı bir fark bulunmamıştır. Öğrencilerin 

uygulama sonunundaki geliştirdikleri animasyonlar incelendiğinde ise deney grubu 

lehine animasyon geliştirme düzeyleri açısından anlamlı bir farklılık olduğu 

görülmektedir.  

 

Anahtar Kelimeler: Mobil öğrenme,  grafik, animasyon, akademik başarı, tutum 
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ABSTRACT 
 
 
 
 

THE EFFECT OF MOBILE LEARNING APPLICATION IN 

GRAPHICS AND ANIMATION LESSON ON STUDENTS' 

ACADEMIC ACHIEVEMENT AND ATTITUDES TOWARD 

MOBILE LEARNING 
 
 

Kadir DEMİR 

 

 

 

Advisor 

Assoc. Dr. Ercan AKPINAR 

 
 

       The aim of this study is to investigate the effect of mobile learning application in 

Graphics and Animation Lesson on students' academic achievement and attitudes toward 

mobile learning. The effect of implementation process on students' animation 

development levels was also investigated. Pre-test – post-test control group quasi-

experimental research design was used in the study as research method. The study is 

conducted with 2nd grade undergraduate students, 15 of them in experimental group and 

26 of them in control group, who studies in Computer Education and Instructional 

Technology Department, Buca Education Faculty, Dokuz Eylul University, in the second 

term of the 2013-2014 academic year. 

 

      Academic Achievement Test and Attitude Scale Towards Mobile Learning were 

administered to both groups for pre-test and post-test in this research as data collection 

tools. In addition, animations which were developed by students were collected as data 

collection tools after instruction. Academic Achievement Test and Attitude Scale 

Towards Mobile Learning results were analyzed with SPSS (22,0 version) software. 

Independent samples t-test and mann-whitney u test were used in order to determine 
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whether there is meaningful difference between both groups’ achievement and attitude 

scores. Animations which were developed by students were evaluated by using 

Animation Development Level Rubric.  

 

There is a significant difference between experimental and control groups in favor 

of the experimental group in terms of academic achievement scores in the post test while 

significant difference has not been found between experimental and control groups in the 

pre test. There is no significant difference between the pre test and post test scores of 

experimental and control groups attitudes towards mobile learning. As the animations 

that the students developed at the end of the implementation were analyzed, it seems that 

there is a significant difference in the aspect of level of developing animation between 

control and experimental group, in favor of experimental group.  

 

Key Words: Mobile learning, graphic, animation, academic achievement, attitude 
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BÖLÜM I 

 

 

GİRİŞ 

 

Problem Durumu 

 
Teknolojinin hızla gelişmesiyle birlikte bireylerin bu gelişen teknolojileri kullanma 

alışkanlıkları da hızlı bir değişim geçirmektedir. Bunlar arasında mobil teknolojiler ve 

bunların kullanımı önemli bir yer tutmaktadır. Mobil teknolojiler bilgiye erişme 

biçimlerimizi köklü bir şekilde değiştirip, belirli bir zamanda ve mekânda bilgiye erişim 

zorunluluğunu ortadan kaldırmaktadır. Kablosuz internete erişim ve mobil servis 

sağlayıcıların imkânlarının artmasıyla birlikte bireylerin her yerde ve her zaman bilgiye 

erişmeleri giderek yaygınlaşmaktadır. Bu yaygınlaşmanın en önemli sebepleri arasında 

mobil teknolojilerin iki temel özelliği olan taşınabilirlik ve kablosuz bağlantı olanağı 

gösterilmektedir (Georgiev, Georgieva ve Smrikarov, 2004). Mobil teknolojilerin günlük 

yaşamdaki bu denli yoğun kullanımına paralel olarak, mobil öğrenme içerikleri günden 

güne artış göstermiştir. Bu durum, öğrencilerin mobil cihazlarla bilgiye erişimini ve 

bilgiyle etkileşimini kolaylaştırarak öğrenciler tarafından bu teknolojilerin eğitim amaçlı 

kullanımını desteklemiştir. Bunun sonucu olarak mobil öğrenme kavramı ortaya 

çıkmıştır.  

 

Mobil öğrenmenin alanyazında farklı tanımları bulunmaktadır. Walker (2007)’a 

göre mobil öğrenme, sadece mobil cihazlar kullanılarak yapılan öğrenme değil, 

bağlamlar arası öğrenmedir. O’Malley ve ark. (2003) mobil öğrenmeyi, öğrenenin 

önceden belirlenmiş bir yerde olmadığı zamanda gerçekleşen herhangi bir çeşit öğrenme 

ya da öğrenenin mobil teknolojilerin sunduğu öğrenme fırsatlarını avantaja çevirebildiği 

zamanda gerçekleşen öğrenme olarak tanımlamaktadır. Trifonova ve Ronchetti (2003) 

mobil öğrenmeyi günlük hayatta her an yanımızda bulundurabileceğimiz taşınabilir 

cihazlar aracılığıyla yapılan e-öğrenme olarak tanımlamaktadır. Stone (2004) mobil 
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öğrenmeyi boyutları küçük, bant genişliği ve ağ teknolojilerine sahip birçok özelliği 

barındıran cihazlarla yapılan e-öğrenme olarak tanımlamaktadır.  Georgieva, Smrikarov 

ve Georgiev (2005) mobil öğrenmeyi öğrenme materyallerini sunabilecek ve öğretmen-

öğrenci arasındaki etkileşimi her yerde, her zaman sağlayacak taşınabilir cihazların 

eğitimde kullanılması olarak açıklamaktadır. Farklı tanımlardan anlaşılacağı üzere mobil 

öğrenmeye ait tek ve kesin bir tanım bulunmamaktadır. Bazı araştırmacılar donanım 

özelliklerini ön plana çıkartırken, bazı araştırmacılar ise bağlamı ön plana çıkartmaktadır. 

Bu noktada mobil cihazların özelliklerinin her geçen gün gelişmesi ve değişmesinin, 

mobil öğrenmenin tanımının zaman içerisinde farklılaşmasına yol açtığı söylenebilir. 

Hızlı değişimler geçiren bu alanla ilgili araştırmacılar mobil öğrenmenin daha etkili hale 

nasıl getirilebileceğine yönelik araştırma yapmaya başlamışlardır. Bununla birlikte mobil 

öğenmede kullanılan mobil cihazların eğitimi nasıl daha iyi hale getireceği de önemli bir 

araştırma konusu olarak yer almaktadır (Trifonova, 2003).  

 

Yurt dışında mobil öğrenme ile ilgili çok sayıda araştırma gerçekleştirilmiştir 

(Chin ve Chen, 2013; Evans, 2008; Gikas ve Grant, 2013; Jumaat ve Tasir, 2013; Hwang 

ve ark., 2014; Kearney ve Maher, 2013; Nestel ve ark., 2014; Taylor ve ark., 2010). 

Ülkemizde ise mobil öğrenme ile ilgili sınırlı sayıda araştırma bulunmaktadır (Korkmaz, 

2010; Yılmaz, 2011; Sur, 2011; Özdamar Keskin, 2011). Yapılan alanyazın taramasında 

Yılmaz (2011) mobil öğrenme konusunda Türkiye’de yapılan araştırmaların yeterli 

olamayacağını belirtmiş ve mobil öğrenmeyi eğitime entegre etmek için yeni araştırmalar 

yapılmasının gerekliliğini vurgulamıştır. Alan yazın incelendiğinde Grafik ve 

Animasyon dersindeki mobil öğrenme uygulamalarının öğrencilerin akademik 

başarılarına ve mobil öğrenmeye yönelik tutumlarına etkisinin incelendiği bir çalışmanın 

bulunmadığı da görülmüştür. 

 

 

 

Problem Cümlesi 

 

Araştırmanın problem cümlesi “Mobil öğrenme uygulamaları Bilgisayar ve Öğretim 

Teknolojileri Eğitimi (BÖTE) Bölümü öğrencilerinin Grafik ve Animasyon dersindeki 

akademik başarılarını ve mobil öğrenmeye yönelik tutumlarını etkilemekte midir?” 
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olarak belirlenmiştir. Ayrıca araştırmada, “Mobil öğrenme uygulamalarının öğrencilerin 

animasyon geliştirme becerileri üzerine etkisi var mıdır?” problemine de cevap 

aranmıştır.  

 

Alt Problemler 

 
 

Araştırmanın alt problemleri şu şekilde belirlenmiştir: 

a) BÖTE Bölümü Grafik ve Animasyon dersinde tablet bilgisayar destekli mobil 

öğrenme uygulamaları ile öğrenim gören öğrenciler ile harmanlanmış öğrenme ile 

öğrenim gören öğrencilerin akademik başarıları arasında anlamlı bir fark var mıdır? 

b) BÖTE Bölümü Grafik ve Animasyon dersinde tablet bilgisayar destekli mobil 

öğrenme uygulamaları ile öğrenim gören öğrenciler ile harmanlanmış öğrenme ile 

öğrenim gören öğrencilerin animasyon geliştirme düzeyleri arasında anlamlı bir fark 

var mıdır? 

c) BÖTE Bölümü Grafik ve Animasyon dersinde tablet bilgisayar destekli mobil 

öğrenme uygulamaları ile öğrenim gören öğrenciler ile harmanlanmış öğrenme ile 

öğrenim gören öğrencilerin mobil öğrenmeye yönelik tutumları arasında anlamlı bir 

fark var mıdır? 

 

 

 

 

Amaç ve Önem 

 

Araştırmanın amacı; Bilgisayar ve Öğretim Teknolojileri Eğitimi (BÖTE) Bölümü 

öğrencilerinin Grafik ve Animasyon dersinde mobil öğrenme uygulamaları ile öğrenim 

görmelerinin akademik başarılarına, mobil öğrenmeye yönelik tutumlarına ve animasyon 

geliştirme düzeylerine etkisinin incelenmesidir.  

 

Mobil öğrenme sınıf içinde ve sınıf dışındaki öğrenme arasındaki bağlantıyı 

kurmaya fırsat tanımaktadır. Bu nedenle okulların öğrencilere mobil cihazlar sağlama 

veya sahip oldukları cihazlara uygun araçlar ve içerikler geliştirmesi zorunluluğu ortaya 

çıkmaktadır (Sharples, 2013). Kişisel ve bağlamsal teknolojiler yaşam boyu öğrenmeyi 
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destekleyerek öğrenme deneyimini zenginleştirmektedir. Öğrenme süreçlerini 

zenginleştirmeyi amaçlayan yurt dışında yapılmış bir çok uygulamalı mobil öğrenme 

araştırması bulunmaktadır (Anderson ve ark., 2013; Chin ve Chen, 2013; Evans, 2008; 

LóPez ve ark., 2013; Martin ve Ertzberger, 2013; Sharples, 2002; Sung ve Mayer, 2013; 

Yang ve ark., 2013). Ülkemizde de araştırmacılar mobil öğrenme ile ilgili uygulamalı 

araştırmalar gerçekleştirmektedir (Korkmaz, 2010; Yılmaz, 2011; Sur, 2011; Özdamar 

Keskin, 2011). Bununla birlikte Avrupa ve Amerika’da bu alanda araştırma kapsamı ve 

imkanları gözönüne alındığında ülkemizde yapılan uygulamalı araştırmaların yeterli 

sayıda olmadığı söylenebilir (Yılmaz, 2011). Yapılan araştırmalarda sunulan önerilere 

aşağıda yer verilmektedir. 

 

       Martin ve Ertzberger (2013) mobil öğrenme çalışmalarında öğrencilerin sistem 

ziyaret sayılarının tutulmasını ve mobil teknolojilerin öğrenme performansı üzerindeki 

etkilerine yoğunlaşılmasını önermektedir. Anderson ve ark. (2013) mobil öğrenmeden 

yararlanılabilmesi için yükseköğretim kurumlarının hızlı internet ağı altyapısını 

kullanıcılara sağlamalarını ifade etmektedir. Çelik (2012) çalışmasında katılımcıların 

kendi cihazlarını kullanmalarını sağlamıştır. Bu yaklaşım katılımcılara aşina oldukları 

cihazları kullanma avantajını sağlarken, ders içeriklerinin ve mobil öğrenmenin aynı 

standartta öğrencilere ulaşmasına engel olmuştur. Farklı mobil cihazların farklı donanım 

özellikleri ve özellikle ekran boyutlarına sahip oldukları düşünüldüğünde bu bir sorun 

olarak ortaya çıkmaktadır. Çelik (2012) bu noktada çözüm olarak mobil öğrenme 

ortamları tasarlanırken öncelikle teknik problemlerin belirlenmesini standartlaşmayı 

sağlayacak zeminin hazırlanmasına gereksinim duyulduğunu dile getirmektedir. Ayrıca 

Çelik (2012) benzer araştırmalarda mobil öğrenme içeriklerine ders saatleri dışında daha 

çok erişim olanağı sağlanmasını önererek, bu sayede öğrencilerin akademik başarısının 

arttırılacağını ifade etmektedir. Ozan (2013) ise bilgiye sürekli erişimin sağlanması için 

ders içeriklerine mobil platformlardan erişilmesini, öğrencilere ihtiyaç duydukları anda 

dönüt sağlanmasını ve tercih edilecek mobil uygulamaların Türkçe dil desteğine sahip 

olmasını önermişlerdir. Sayın (2010) öğrencilerin mobil öğrenme ortamlarında giriş 

zamanlarını ve bu ortamlarda geçirdikleri sürenin raporlanabilmesini ön plana 

çıkarmıştır. Sur (2011) mobil öğrenme sistemine bağlanılan cihazların cep telefonu 

ekranı yerine daha büyük ekranlara sahip olmasını ve internet bağlantısını daha etkin 

kullanabilecek mobil cihazların kullanılmasını önermektedir. Yılmaz ve Akpinar (2011) 
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mobil cihazların öğrenciler ve eğitimciler için ihtiyaç olduğunu belirtmişlerdir. Yapılan 

araştırma yurtiçinde ve yurtdışında yapılan araştırmaların yukarıda ifade edilen önerileri 

doğrultusunda tasarlanarak oluşturulmuştur. Bu öneriler dikkate alındığında yapılmış 

olan bu araştırmanın, mobil öğrenme alanında yapılan uygulamalı çalışmalara katkı 

sağlayacağı düşünülmektedir.  

 

Mobil cihazlar yüksek işlem kapasiteleri ve her geçen gün gelişen yeni özellikleriyle 

birlikte büyük ilgi çekmektedir. Sosyal medya ve web teknolojilerinde yaşanan 

gelişmeler mobil cihazları hayatımızın vazgeçilmez birer parçası yapmışlardır. 

Öğrencilerin de bu gelişmeleri yakından takip ettiği göz önünde bulundurularak, gerek 

yurt içerisinde gerekse yurt dışında mobil cihazların ve mobil öğrenme uygulamalarının 

akademik başarıyı ve tutumu nasıl etkilediğine yönelik birçok araştırma yapılmaktadır 

(Al-Fahad, 2009; Chen ve Kessler, 2013; Cheon ve ark., 2012; Ciampa, 2014; Jaradat, 

2014; Kutluk ve Gülmez, 2014; Martin ve Ertzberger, 2013). İlgili araştırmalar 

incelendiğinde mobil öğrenme ile ilgili öğrenci başarı, tutum ve görüşlerine yönelik 

çalışmalar yapılması gerektiği belirtilmektedir (Jaradat, 2014; Martin ve Ertzberger, 

2013; Özdamar Keskin, 2011). 

 

Ülkemizde mobil teknoloji destekli öğrenme ortamlarına yönelik bazı çalışmalar son 

yıllarda önem kazanmış ve ulusal düzeyde projeler başlatılmıştır. Bunlardan en geniş 

kapsamlı olanı Fırsatları Artırma ve Teknolojiyi İyileştirme Hareketi (FATİH) projesidir. 

Milli Eğitim Bakanlığı tarafından yürütülen FATİH Projesi kapsamında okulöncesi, 

ilköğretim, ortaöğretim öğrencilerine ve öğretmenlerine tablet bilgisayar verilmesi ve bu 

şekilde bilişim teknolojileri destekli öğretimin gerçekleştirilmesi amaçlanmaktadır (Fatih 

Projesi, 2013). Bütün bu gelişmeler dikkate alındığında mevcut öğretmenlerin ve 

öğretmen adaylarının okul ortamında ders işlerken ve ders materyalleri hazırlarken mobil 

öğrenmeyi etkin bir şekilde nasıl kullanacağını bilmesi önemli görülmektedir. Bu 

araştırmada öğretmen adayları ile çalışılmış ve böylece bu kazanımları hizmet öncesinde 

elde etmeleri umulmaktadır. Yakın gelecekte ikinci sınıf lisans öğrencilerinin öğretmen 

olacağı düşünüldüğünde yapılan çalışmanın FATİH projesine de katkı sağlayabileceği 

umulmaktadır. 

 

 

http://www.fatihprojesi.com/
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      Bu araştırmada öğretmen adaylarının mobil öğrenme ortamları ile tanıştırılması, 

tablet destekli mobil öğrenme uygulamaları ile öğrenim görmeleri, mobil teknolojilere 

belirli bir süreliğine sahip olmaları önemli görülmektedir. Bu sayede mobil öğrenmeye 

ve mobil teknolojilere yönelik farkındalıklarının artacağı düşünülmektedir. Ayrıca bu 

araştırmanın mobil öğrenmenin lisans öğreniminde kullanımını incelemek için gelecekte 

yapılacak araştırmalara ışık tutacağı düşünülmektedir. Ayrıca bu araştırma öğretmen 

adaylarının öğrenme ve öğretme sürecini zenginleştirebilmek için uygun öğrenme 

ortamları tasarlayabilmeleri ve güncel teknolojileri bilmeleri açısından da önemli 

görülmektedir. Yapılan araştırma yurtiçinde ve yurtdışında yapılan araştırmaların 

önerileri doğrultusunda tasarlanarak oluşturulmuştur (Anderson ve ark., 2013;Çelik, 

2012; Martin ve Ertzberger, 2013; Ozan, 2013; Sayın, 2010; Sur, 2011). Bu öneriler 

dikkate alındığında yapılmış olan bu araştırmanın, mobil öğrenme alanında yapılan 

uygulamalı çalışmalara katkı sağlayacağı düşünülmektedir.  

 

 

 

Sayıltılar 

 

1. Her iki gruptaki katılımcıların bilgisayar kullanma becerilerinin eşit düzeyde 

olduğu varsayılmıştır.  

 

Sınırlılıklar 

 

1. Bu araştırma, çalışma grubunu oluşturan Dokuz Eylül Üniversitesi Buca Eğitim 

Fakültesi BÖTE Bölümü ikinci sınıfta öğrenim gören 41 (15 Deney, 26 Kontrol) 

lisans öğrencisi ile sınırlıdır. 

2. Bu araştırma, lisans ikinci sınıf bahar döneminde açılan BLÖ 2006 Eğitimde 

Grafik ve Canlandırma dersi ile sınırlıdır. 

3. Bu araştırma öğrenme yönetim sistemlerinden biri olan Blackboard öğrenme 

yönetim sistemi kullanılmıştır. 

4. Deney ve kontrol grubu öğrencileri diğer dersleri aynı şubede birlikte aldıkları 

için aralarında etkileşim olmuştur. 
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BÖLÜM II 
 
 
 

İLGİLİ YAYIN VE ARAŞTIRMALAR 
 
 

Mobil Öğrenme 

 

Mobil öğrenme projeleri öğrenme etkinliklerinin kapsamını genişlettiği ve 

zenginleştirdiği için gün geçtikçe daha da artmaktadır. Mobil öğrenmeye artan bu ilgide 

mobil teknolojilerdeki hızlı gelişim ve değişimlerin destekleyici etkiside büyük 

orandadır. Aynı zamanda kullanıcıların bu teknolojileri kısa zamanda benimsemesi 

mobil öğrenme açısından yararlı olarak görülmektedir. 

 

Mobil öğrenme aracılığı ile sanal ve gerçek dünyadaki insanlar birbirleri ile bağlantı 

kurabilmektedir. İnsanlar hareket halinde iken, kendi aralarında öğrenme toplulukları 

oluşturulabilmektedir. Mobil öğrenme bu özellikleri göz önüne alındığında yaşam boyu 

öğrenme ve hizmet içi eğitimi destekleyici bir unsur olarak ön plana çıkmaktadır. Mobil 

öğrenme sınıf dışındaki etkileşimi sayesinde eğitimin sınıf dışında da devam etmesini 

sağlamaktadır (Sharples ve ark., 2009). 

 

Öğrenenler mobil cihazların bağlantı özelliklerinin gelişmesiyle birlikte her yer de 

her zaman birbirleriyle etkileşimde bulunabilmekte, bilgiyi saklamak yerine ihtiyaçları 

olduğunda o bilgiye mobil cihazlar aracılığıyla erişebilmektedir. Mobil cihazların 

taşınabilir olması ve istenildiği zaman bilgiye erişme imkanı sunabilmesi öğrenene 

istediği yerde olabilme özgürlüğünü vermektedir. Bu sayede mobil cihazlar, öğrenmeyi 

sosyo-kültürel ve bilişsel açıdan etkilemektedir (Pachler, 2009). 

 

Birçok araştırmacı mobil öğrenme uygulamaları ve projelerinin başarıya 

ulaşmasında göz önüne alınması gereken kriterleri belirtmişlerdir. Traxler ve Wishart, 

(2011) mobil öğrenme çalışmalarında göz önünde tutulması gereken kriterleri teknik, 

pedagojik ve kurumsal olarak üç başlık altında toplamıştır. 
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1. Teknik 

 

Bağlanabilirlik: Mobil öğrenme çalışmasında kullanılacak örnek bir cihaz alınarak 

çalışmanın gerçekleşeceği ortamlarda deneme yapılmalı. 

 

Batarya ömrü: Yedek şarj üniteleri bulundurulmalı. 

 

Kamera çözünürlüğü: Maliyeti karşılanabilecek en iyi kamera çözünürlüğüne sahip 

ürün alınmalı. 

 

Yenisiyle değiştirme: Arızalanma veya zarar görme durumuna karşı tedbir olarak yedek 

cihazlar bulundurulmalı. 

 

2. Kurumsal 

 

Ortaklık: Mobil öğrenme çalışmasının yapılacağı kurum ile ortak hareket edilerek, 

mobil telefon yasakları, kablosuz internet erişim izinleri, araştırma boyunca çekilen 

resimlerin sahipliği ve kullanımı hakkındaki konular tartışarak çözülmeli. 

 

Cihazların sahipliği: Öğrencilerin kendi mobil cihazlarına sahip olup olmadığı 

araştırılmalı, cihaza sahip olmayan öğrenciler için bir kısmı veya tamamı kurum 

tarafından finanse edilmeli. 

 

Beklenmedik durum:  Önceden kestirilemeyen olaylar ile ilgili öğrenciler ve kurumdaki 

meslektaşlar ile birlikte tartışma ortamı oluşturulabilmesi için zaman yaratmalı. 

 

 

 

 

 

3. Pedagojik 
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Öğrenme fırsatları: Öğretilen konuya öğrencinin odaklanabilmesi için güdüleyici 

fırsatlar tanımlanmalı. 

 

Yapılandırmacı yaklaşım: Gerçek bağlam ve sınıf arasında öğrenme fırsatları 

oluşturulmalı. 

 

Öğrenci özerkliği: Öğrencinin kişisel cihazını kullanarak kendi öğrenmesini 

destekleyecek en iyi yolu seçmesine imkan tanınmalı. 

 

Mobil öğrenme çalışmalarının başarıyla yürütülebilmesi için Naismith ve ark. 

(2004) dikkat edilmesi gereken noktaları belirtmişlerdir. Bu noktalar: 

 

Bağlam: Öğrencilerden toplanan ve kullanılan bağlamsal bilginin öğrencinin 

mahremiyetini ihlal edebilir. 

 

Hareketlilik: Ders aktivitelerine her yerden erişebilme imkanı sunması öğrencilere 

istedikleri zaman istedikleri mekanda olma serbestliğini sunmalıdır. 

 

Zamanla öğrenme: Mobil öğrenme deneyimlerinin sonuçlarını kayıt etme, düzenleme 

ve toplamak için etkili araçlar kullanılmalıdır. 

 

Kayıtdışılık: Öğrenciler sürekli kullandıkları sosyal ağlar mobil öğrenme çalışmaları 

nedeniyle yoğun saldırıya maruz bırakıldığında bu ağları kullanmaktan vazgeçebilir. 

 

Sahiplik: Öğrenciler kendi mobil cihazlarını kontrol etmek istemekte fakat bu cihazları 

sınıfa getirdiklerinde, mobil öğrenme çalışmalarındaki değişkenlerin kontrol altına 

alınamaması gibi zorluklar ortaya çıkmaktadır. 

 

 

Mobil Öğrenme Tasarımı 
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Mobil öğrenme araştırmaları incelendiğinde geçmiş yıllarda donanım ön planda iken 

günümüzde mobil öğrenmenin içeriği ve mobil öğrenme tasarımı ön plana çıkmaktadır. 

Mobil öğrenme, sadece e-öğrenme nesnelerinin mobil cihazlara aktarılması ile yapılan 

öğrenme olarak görülmemelidir. Mobil cihazlara yönelik ve mobil tasarım ilkelerine 

temel alınarak mobil öğrenme nesneleri oluşturulmalıdır.Mobil öğrenme içerikleri çok 

fazla bilgi içermek yerine küçük parçacıklar halinde verilmelidir. Bu tarzda küçük 

parçacıklar halindeki mobil öğrenme içerikleri “nuggets” veya “bite-sized” olarak 

adlandırılmaktadır (Parsons, Ryu ve Cranshaw, 2006). Naismith ve Corlett (2006) mobil 

öğrenme tasarımı ile ilgili dikkat edilmesi gereken noktaları aşağıdaki şekilde 

belirtmişlerdir:  

 Hızlı ve basit etkileşimler yaratmak, 

 Öğrenenin ihtiyaçlarına göre değişebilecek esnek materyaller hazırlamak, 

 Cihazların ve standartların farklılığı göz önünde bulundurularak erişim ve 

etkileşimi tasarlamak, 

 Mobil cihazların özelliklerini ve kısıtlamalarını kullanarak öğrenen deneyimine 

katkıda bulunmak, 

 Mobil cihazlardaki yerel uygulamaları (not defteri, kamera, takvim, ses kayıt) 

kullanarak mobil teknolojileri sadece öğrenme içeriklerini dağıtan bir araç olarak 

değil, öğrenmeyi kolaylaştırıcı olarak kullanmak, 

 Öğrenen merkezli tasarım yaklaşımı ile materyal tasarlamak. 

 

Herrington ve ark. (2009b) mobil öğrenme için tasarım prensipleri oluşturmuşlardır. 

Bu prensipler aşağıda listelenmiştir. 

 

1. Gerçek dünyayla ilişki (Real world relevance): Mobil öğrenme gerçek 

bağlamlarda kullanılmalı.  

2. Mobil bağlamlar (Mobile contexts): Mobil öğrenme öğrenenlerin mobil olduğu 

bağlamlarda kullanılmalı. 

3. Keşfetme (Explore): Mobil teknolojileri keşfedecek zaman sağlanmalı. 

4. Harmanlanmış (Blended): Mobil ve mobil olmayan teknolojiler 

harmanlanmalı. 

5. Herhangi bir zamanda (Whenever): İstenildiği zaman kullanılmalı. 
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6. Herhangi bir yerde (Wherever): Geleneksel olmayan öğrenme alanlarında 

kullanılmalı. 

7. Her kimse (Whomsoever): Bireysel ve işbirlikli öğrenmenin her ikisi için de 

kullanılmalı. 

8. Sağlayıcılık (Affordances): Mobil teknolojilerin özelliklerinden faydalanılmalı. 

9. Kişiselleştirme (Personalise): Öğrenenlerin cihazları sahiplenmesi sağlanmalı. 

10. Aracılık etme (Mediation): Bilgiyi yapılandırmaya aracılık etmeli. 

11. Üretme ve Kullanma (Produse): Bilgiyi üretme ve tüketmesi sağlanmalı. 

 

      Yapılan bu araştırmada da hızlı ve etkileşimli ders içerikleri oluşturulmuş ve mobil 

cihazlardaki yerel uygulamaların kullanılması sağlanarak, mobil öğrenme öğrenmeyi 

kolaylaştırıcı olarak sunulmuştur. Ayrıca, mobil cihazların araştırma boyunca 

öğrencilerde kalması sağlanarak, öğrencilerin bu cihazları kişiselleştirebilmesi 

sağlanmıştır. 

 

Mobil Öğrenmede Değerlendirme 

 

Mobil öğrenmenin değerlendirilmesinde veri toplama, analiz etme ve sunma 

aşamaları esnasında birçok sorunla karşılaşılmaktadır. Karşılaşılan bu sorunlar e-

öğrenme ve uzaktan öğrenme değerlendirilirken yaşanan sorunlarla benzer niteliktedir. 

Mobil öğrenmeyi değerlendirebilmek için mobil öğrenme tanımı ve kavramından yola 

çıkmak gerekmektedir. Ancak mobil öğrenme tanımı ve kavramı üzerinde alanda 

birbirinden farklı görüşler olduğu için değerlendirmede de ortak paydada buluşamamanın 

sıkıntıları yaşanmaktadır (Traxler, 2007). 

 

Mobil öğrenme değerlendirmesi yapılandırılırken kullanılabilirlik, eğitimsel 

yararlılık ve genel etkililiği etrafında bir değerlendirme planı oluşturulmaktadır. Mikro 

seviyede öğrenenlerin mobil öğrenme aktiviteleri esnasında kullandıkları mobil 

teknolojilerin kullanılabilirliği, verimliliği, etkililiği ve tatmin ediciliği incelenmektedir. 

Orta seviyede öğrenen deneyimi, yeni teknolojilerin eğitimsel değeri, eğitimi nasıl 

değiştirebileceği, sağladığı katkıları ve ortaya çıkardığı sorunlar incelenmektedir. Makro 

seviyede yeni teknolojinin uzun vadede getireceği etkiler, öğrenme ve öğretmeye 

getireceği yenilikler, istekler ve beklentiler incelenmektedir (Sharples ve ark., 2009). 
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      Yapılan bu araştırmada da öğrenen deneyimi, yeni teknolojilerin eğitimsel değeri, 

eğitimi nasıl değiştirebileceği, sağladığı katkıları ve ortaya çıkardığı sorunlar 

incelenmektedir. 

 

Mobil Uygulamalar 

 

Mobil uygulamalar “Yerel Uygulamalar” (Native apps), “HTML5 Uygulamaları” 

(HTML5 apps) ve Hibrid Uygulamalar (Hybrid apps) olmak üzere üçe ayrılmaktadır. 

Yerel Uygulamalar (Native apps), geliştirme araçları (Xcode, Eclipse) ve programlama 

dilleri (Objective-C, Swift, Java) kullanılarak mobil platformlar (iOS, Android) için özel 

olarak geliştirilen uygulamalardır. Yerel uygulamalar donanım ve yazılım özelliklerine 

tam erişim sağlamaları ve çevrimdışı depolama özellikleri sayesinde mobil cihazlarda en 

iyi performansı gösteren uygulamalardır. HTML5 Uygulamaları (HTML5 apps), 

HTML5, Javascript ve CSS kullanılarak oluşturulan uygulamalar Web uygulamaları 

(Web apps) olarak da bilinmektedir. En önemli avantajı, çapraz platformlarda çalışabilen 

mobil uygulamalar oluşturulabilmesidir. Sınırlılıkları ise oturum yönetimi, çevrimdışı 

depolama özellikleri ve donanım ve yazılım özelliklerine erişim sağlayamamasıdır. 

Hibrid Uygulamalar (Hybrid apps), yerel ve HTML5 uygulamalarının birleşimidir. 

HTML5, Javascript ve CSS kullanılarak oluşturulan HTML5 uygulaması donanım ve 

yazılım özelliklerine erişim sağlayacak şekilde yerel uygulama katmanının içine 

yerleştirilerek oluşturulmaktadır. Örneğin Phonegap mobil çoklu platform destekli 

çalışma ortamında iOS, Android, WebOS, Blackberry OS, Windows Mobile mobil 

işletim sistemlerine yönelik hibrid uygulamalar oluşturulabilmektedir. (Korf ve 

Oksman,2012; PhoneGap). Yerel ve hibrid uygulamalar uygulama marketleri tarafından 

dağıtıldıkları için HTML5 uygulamalarına göre daha güvenlidir. Uygulama marketleri 

uygulamaları son kullanıcılara sunmadan önce belirli kriterlere göre gözden 

geçirmektedir. Bu kriterler arasında gizlilik, fikri mülkiyet, zararlı içerik ve reklamlar yer 

almaktadır (Google Play Policies and Guidelines, 2013). 

 

      Bu araştırmada, yerel uygulamalar kullanılarak mobil cihazların donanım ve yazılım 

özelliklerine tam erişim sağlanması hedeflenmektedir. Bununla birlikte oluşturulan ders 
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içerikleri ve örnek animasyonlar HTML5 formatında derlenerek, cihaz ve tarayıcı 

kaynaklı sorunların önüne geçilmesi hedeflenmiştir. 

 

Harmanlanmış Öğrenme 

 

       Çevrimiçi öğrenme teknolojilerinin eğitimde kullanılması kuşkusuz büyük yarar 

sağlamaktadır. Bununla birlikte sadece bu teknolojilere dayalı olarak öğrenimin 

gerçekleştirilmesi, öğrenciler açısından yüzyüze öğrenmenin avantajlarını kullanamama 

sonucunu doğuracaktır. Bununla birlikte çevrimiçi öğrenmenin ve yüzyüze öğrenmenin 

olumlu yönlerini bir arada buluşturarak üst seviyede faydalanmak amacıyla 

harmanlanmış öğrenme kullanılmaktadır (Graham, 2006; Thorne, 2003) 

 

Öğrenme Yönetim Sistemleri 

 

Ifenthaler (2012) öğrenme yönetim sistemlerini (LMS) öğrenme içeriklerinin 

interaktif öğrenme ortamlarında kullanıcılar tarafından yönetilmesi ve kullanılmasını 

sağlayan web tabanlı yazılımlar olarak tanımlamaktadır. Bu sistemler sayesinde 

eğitimciler, kullanıcılar, dersler ve ders içerikleri, öğrenme yönetim sistemlerinde 

bulunan ve bu sistemlere dışarıdan da entegre edilebilen değerlendirme, not verme, 

ödevlere dönüt verme, iletişim gibi kapsamlı araçların yardımıyla yönetilebilmektedir. 

Paulsen (2002) ise öğrenme yönetim sistemlerini; erişim kontrolü, öğrenme içeriklerini 

barındırma, iletişim araçları ve kullanıcı gruplarını organize etme özellikleri barındıran, 

öğrencilerin, öğretmenlerin ve yöneticilerin sistemlere erişebilmelerini ve 

yönetebilmelerini sağlayan sistemler olarak tanımlamaktadır 

 

Öğrenme yönetim sistemleri kullanıcıları arasında öğrenciler, öğretmenler, 

yöneticiler, eğitim yöneticileri, içerik geliştiriciler ve denetçiler bulunmaktadır. Birçok 

kurumun merkezi öğrenme portalında çevrimiçi dersler, sınıf olaylarına kayıt, canlı sanal 

sınıflar ve uzaktan öğrenme bulunmaktadır. Öğrenme yönetim sistemleri güvenli erişim 

ve giriş, e-öğrenme kayıtlarını tutma, öğrenci anketleri ve değerlendirmeleri, testler 

oluşturma ve uygulama, sınıf yönetimi, notlandırma, işbirlikli öğrenme, sertifika 

yönetimi, çoklu dil desteği, beceri boşluk analizi,  gelişmiş öğrenme analizi özelliklerini 
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bünyesinde barındırmaktadır (Chapman, 2008). Yapılan bu araştırmada kullanılan 

öğrenme yönetim sistemine ait detaylı bilgiler yöntem bölümünde açıklanmıştır. 

 

Mobil Öğrenme İle İlgili Araştırmalar 

 
 

Mobil öğrenme araştırmaları, teknoloji aracılığıyla hareket halinde öğrenenlerin yeni 

bilgi, beceri ve deneyimleri nasıl kazandıkları ile ilgilenmektedir (Sharples ve ark., 

2009). Mobil teknolojilerin hızlı değişimi mobil öğrenme araştırmalarında 

araştırmacılara ve öğrenenlere bazı dezavantajlar getirmektedir. Öğrenenler yeni 

cihazların özelliklerine alışmak için zaman harcamakta, araştırmacılar boylamsal 

çalışmaları yaparken zorlanmaktadır. Öğrencilerin mobil cihazlara sahip olması, bireysel 

ihtiyaçlarına göre cihazları kişiselleştirebilmelerini ve mobil cihazları öğrenmede 

kullanma isteklerinin artmasını sağlamaktadır. Bu durum araştırmacıların değişkenler 

üzerinde daha az kontrol sahibi olması gibi bir dezavantajı da ortaya çıkartmaktadır 

(Pachler, 2009). Mobil öğrenme ile ilgili birçok araştırma yapılmıştır. Bu araştırmalardan 

bazıları şunlardır: 

 

Özdamar Keskin (2011), çalışmasında akademisyenlerin mesleki gelişim 

gereksinimlerini karşılamaya yönelik bir mobil öğrenme sisteminin tasarımlanmasını ve 

bu sistemi kullanan akademisyenlerin algılarının ve deneyimlerinin incelenmesini 

amaçlamıştır. Araştırmasında tasarım tabanlı araştırma ve eylem araştırma yöntemi 

birlikte kullanılmıştır. Veri toplama aracı olarak; araştırmacı günlüğü, odak grup 

görüşmesi, anket, yarı yapılandırılmış görüşme, kişisel bilgi formu, kontrol listesi, 

değerlendirme formu, sistem logları kullanılmıştır. Akademisyenlerin bilimsel araştırma 

boyutundaki mesleki gelişim gereksinimlerini karşılamak için kurs, çevrimiçi kaynaklar, 

danışmanlık, iletişim, sürecim ve yardım bölümlerinden oluşan mobil öğrenme sistemi 

tasarlanmıştır. Aynı sistemin WAP uygulaması ve IOS tabanlı mobil uygulaması 

geliştirilmiştir. Sonuç olarak akademisyenlerin; bilimsel araştırma, akademik 

danışmanlık ve öğretim bağlamındaki gereksinimleri için mesleki gelişim amaçlı mobil 

teknolojilerin kullanımına ve mobil teknolojileri mesleki gelişim amaçlı kullanmaya 

olumlu yaklaştıkları saptanmıştır. 
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       Ozan (2013), çalışmasında yönlendirici destek hizmetlerini sunmak üzere bir mobil 

öğrenme ortamı tasarlamıştır. Araştırmaya Bilgisayar ve Öğretim Teknolojileri Eğitimi 

Bölümü’nde öğrenim görmekte olan toplam 48 lisans öğrencisi katılmıştır. Veri toplama 

aracı olarak nitel ve nicel araçlar kullanılmıştır. Araştırmacı günlüğü, yarı yapılandırılmış 

görüşmeler, Facebook grup duvarı iletileri, Facebook kişisel mesajları, Facebook 

sohbetleri, katılımcıların Blog girdileri, e-postalar, Twitter iletileri, Diigo girdileri, Mobil 

öğrenme yönetim sistemi istatistikleri, algılanan öğrenme (perceived learning) anketi ve 

demografik bilgi formu kullanılmıştır. Elde edilen araştırma sonuçlarına göre bağlantıcı 

mobil ortamlarda sağlanacak yönlendirici desteğin türü, sağlayıcısı, zamanlaması ve 

stratejileri olmak kaydıyla dört bileşenden oluşmuştur. Öğrenciler sırasıyla sosyal 

desteği, yönetim desteğini, öğretim desteğini ve son olarak teknik desteği 

kullanmışlardır. Sonuç olarak mobil cihazların kullanımının derse karşı olan ilgi ve 

motivasyonu arttırdığı bulunmuştur. Ayrıca, öğrenmenin daha kalıcı olduğunu, sosyal 

ağların ve mobil teknolojilerin kullanımının öğrenci performanslarını olumlu etkilediğini 

ve öğrenme süreçlerini yönetmeyi kolaylaştırdığı sonucuna ulaşmıştır. 

 

      Çelik (2012), çalışmasında amacı, cep telefonu ve karekod kullanılarak sunulan 

mobil çevrimiçi bir sözlük yazılımının, öğrencilerin aktif sözcük öğrenmeleri 

üzerindeki etkisini ve görüşlerini belirlemeyi amaçlamıştır. Araştırmaya, 2010–2011 

öğretim yılı bahar döneminde Gazi Üniversitesi Yabancı Diller Yüksekokulu Modern 

Yabancı Diller Birimi Orta Seviye sınıfta öğrenim gören her bir grupta 25 olmak üzere 

toplam 50 lisans öğrencisi katılmıştır. Çalışmaya katılan öğrenciler, ders kitabındaki 

sözcükleri Mobil Sözlük isimli çevrimiçi sözlük programı aracılığıyla öğrenmişlerdir. 

Araştırma sonuçları, ders içi aktivitelerde kullanılan mobil destekli yabancı dil öğrenme 

ortamının, öğrenenlerin aktif sözcük bilgisi düzeylerinde artış sağladığını ortaya 

çıkartmıştır. Araştırma sonunda öğrenciler farklı derslerde de, karekod destekli 

öğrenme ortamlarını kullanmak istediklerini dile getirmişlerdir. Bununla birlikte mobil 

cihazlarda yaşanan teknik aksaklıklardan ötürü zaman zaman katılımcıların olumsuz 

etkilendiği görülmektedir. Ayrıca öğretim ortamında kullanılan karekodun, 

öğrencilerin derse yönelik motivasyonlarını arttırdığı saptanmaktadır. 
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      Yılmaz (2011), çalışmasında Bilgisayar ve Öğretim Teknolojileri Eğitimi (BÖTE) 

bölümü lisansüstü öğrencilerinin ve öğretim elemanlarının mobil öğrenmeye yönelik 

farkındalık düzeylerinin ortaya konulmasını amaçlamıştır. Nitel araştırma yöntemi 

kullanılarak gerçekleştirilen araştırmanın veri toplama aracı görüşme yöntemi ile 

gerçekleştirilmiştir. Örneklem grubu, mobil öğrenmeye yönelik çalışmaya sahip olan ve 

olmayan BÖTE bölümü profesör, doçent, yardımcı doçent, öğretim görevlisi, araştırma 

görevlisi ve lisansüstü öğrencilerinden oluşan 20 kişidir. Araştırma sonuçları, 

katılımcıların mobil öğrenmeye yönelik kuramsal farkındalık düzeylerinin yüksek 

olduğunu ortaya koymuştur. Mobil öğrenmeye yönelik çalışması bulunan katılımcıların 

alan yazındaki uygulamalara hakim oldukları, mobil öğrenmeye yönelik çalışması 

bulunmayan katılımcıların ise mobil öğrenme uygulamalarına ilişkin farkındalıklarının 

teorik düzeyde olduğu saptanmıştır.  

 

 

Gikas ve Grant (2013), çalışmalarında mobil cihazlarla gerçekleştirilen öğretime 

karşı öğrencilerin bakış açısını ortaya çıkartmayı amaçlamışlardır. Araştırmaya üç 

öğretim elemanı ve her öğretim elemanının ders verdiği iki ve dört arasında öğrenci 

katılmıştır. Veri toplama aracı olarak odak grup görüşmesi gerçekleştirilmiştir. Odak 

grup görüşmeleri internet üzerinden Skype yazılımı aracılığı ile gerçekleştirilmiş ve kayıt 

altına alınmıştır. Çalışma sonucunda ortaya iki tema çıkmıştır. Birinci tema “öğrenciler 

için mobil cihazlarla öğrenmenin avantajları” ve ikinci tema “mobil cihazlarla 

öğrenmeden kaynaklanan engellenme” olarak belirlenmiştir. Birinci temayı oluşturan 

etkenler bilgiye hızlıca erişim, iletişim, öğrenme yollarının çeşitliliği ve yerinde 

öğrenme; ikinci temayı oluşturan etkenler ise teknoloji karşıtı öğretim elemanları, cihaz 

zorlukları, dikkat dağıtıcı cihazlar olarak belirlenmiştir. 

 

Evans (2008), çalışmasında podcast ile gerçekleştirilen mobil öğrenmenin lisans 

öğrencileri üzerindeki etkisini incelemiştir. Çalışmada 200 lisans öğrencisine Apple iPod 

cihazı üzerinden ses ve video içerikleri sunulmuştur. Likert tipi 5’li ölçekle tutumları 

araştırılmıştır. Sonuç olarak öğrencilerin bu yöntemi kitaplara göre daha etkili ve öğretici 

bulduğunu ve öğrenmelerine daha çok yardımcı olduğu belirlenmiştir.  
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       Oberer ve Erkollar (2013), çalışmalarında doğa bilimleri, mühendislik bilimleri, 

sosyal bilimler ve hukuk fakültelerinden öğrenciler için Pazarlamaya Giriş (Introduction 

to Marketing) dersinin mobil öğrenme modülleri ile entegre edilmesi amaçlanmıştır. 

Tabletler ve akıllı telefonlar kullanılarak gerçekleştirilen bu çalışmada öğrenciler 

bireysel ödevlerinin yanı sıra grup projelerini de mobil cihazlar üzerinden işbirlikli 

çalışmayla gerçekleştirmişlerdir. Veri toplama aracı olarak ölçek kullanılan bu çalışma 

sonucunda, öğrencilerin %92’sinin grup içi iletişim için sosyal medya siteleri olan 

Facebook ve Google Plus’ı kullandıkları görülmüştür. Öğrencilerin %67’sinin daha önce 

ders amacıyla bu siteleri kullanmadıkları sonucuna ulaşılmıştır. Çalışma sonuçları mobil 

öğrenmenin öğrencilerin katılımı için cesaretlerini arttırdığını, projelerinden daha yüksek 

sonuçlar almalarını sağladığını ortaya çıkarmıştır. 

 

      Kutluk ve Gülmez (2014), çalışmalarında Muhasebe dersi alan lisans öğrencilerinin 

mobil öğrenmeye karşı bakış açılarını belirlemeyi amaçlamışlardır. Örneklemi iki veya 

daha fazla Muhasebe dersi alan Kamu Yönetimi, Kamu Finansı ve Ekonomisi 

bölümlerinden 4. sınıf lisans öğrencileri oluşturmaktadır. Veri toplama aracı olarak 

anketlerin kullanıldığı bu çalışmada, 540 öğrenciye anketler uygulanmıştır. Sonuç olarak 

öğrenciler tarafından kolay kullanılabilecek içeriklerin önemli olduğu belirlenmiştir. 

Ayrıca, eğer teknolojik destek sağlanırsa mobil cihaza sahip olmayan öğrencilerin de 

derslerinde mobil öğrenmeyi kullanma konusunda istekli olduğu sonucuna ulaşılmıştır.  

 

       Köse, Koç ve Yücesoy (2013), çalışmalarında mobil artırılmış gerçeklik araçlarıyla 

teknik derslerdeki eğitsel süreçleri geliştirmeyi amaçlamışlardır. Artırılmış gerçeklik 

araçları ile öğrenciler üç boyutlu animasyonları, özel yapım videoları izlemişlerdir. 

Bilgisayar Bilimleri dersinde kullanılan bu uygulama iOS, Android ve Blackberry işletim 

sistemlerine uyumlu olarak geliştirilerek öğrencilerin cihazlarında çalıştırılırken uyum 

sorunlarının yaşanmaması hedeflenmiştir. Bilgisayar Mühendisliği, Bilgisayar Eğitimi 

ve Bilgisayar Teknolojileri alanından 200 lisans öğrencisi ile gerçekleştirilen bu 

çalışmada 100’er öğrenciden oluşan deney ve kontrol grupları oluşturulmuştur. Deney 

grubuna artırılmış gerçeklik destekli mobil uygulama ile öğrenme, kontrol grubuna ise 

öğrenme yönetim sistemi desteği ve farklı e-öğrenme araçları ile destek verilmiştir. 

Çalışma sonunda mobil uygulamaların deney grubunda yer alan öğrencilerin akademik 
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başarısını anlamlı bir şekilde arttırdığı ortaya çıkmıştır. Ayrıca, öğrenme deneyimini 

başarılı ve etkili bir şekilde geliştirdiği belirlenmiştir. 

 

       Yukarıdaki araştırmaların sonuçları dikkate alındığında mobil öğrenmenin öğrenciler 

için bilgiye hızlı erişim, öğrenme yollarının çeşitliliği, yerinde öğrenme, öğrenmeleri 

üzerinde kontrol sahibi olma, öğrenmelerine yardımcı olma, teşvik edici olma, derse katılımı 

arttırma, derslerinde kullanma konusunda istekli olma ve akademik başarılarında anlamlı 

farklılık oluşturma etkenlerini ortaya çıkarttığı görülmektedir. Ancak yapılan çalışmalar 

incelendiğinde mobil öğrenme alanında uygulamalı çalışmaların çok az olduğu 

görülmektedir (Yılmaz, 2011). Yapılan bu araştırmada ise BÖTE Bölümü öğrencilerinin 

Grafik ve Animasyon dersinde mobil öğrenme uygulamaları ile öğrenim görmelerinin 

akademik başarılarına, mobil öğrenmeye yönelik tutumlarına ve animasyon geliştirme 

düzeylerine etkisi araştırılmıştır. Araştırmanın yapılmış olan deneysel mobil öğrenme 

araştırmalarına katkı yapması beklenmektedir. Özellikle de animasyon derslerinde mobil 

öğrenme çalışmalarının az olması nedeniyle bu alanda daha sonra yapılacak araştırmalara 

temel oluşturacağı düşünülmektedir. 
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BÖLÜM III 
 
 

 

YÖNTEM 
 

 

Araştırma Modeli 

 

Araştırma yöntemi olarak öntest-sontest kontrol gruplu yarı deneysel araştırma 

modeli kullanılmıştır. Deneysel araştırmaların amacı, araştırmacının manipüle ettiği 

bağımsız değişkenler ile bağımlı değişkenler arasındaki ilişkileri ortaya çıkarmaktır 

(Büyüköztürk, Çakmak, Akgün, Karadeniz ve Demirel, 2009). Çalışma grubunu 

oluşturan sınıf, deney grubu15 kişi ve kontrol grubu 26 kişiden oluşmak üzere iki gruba 

ayrılmıştır.  

 

 

Tablo 1 

Araştırmada Kullanılacak Deneysel Desen 

 

Grup Ön test Uygulama Son test 

Deney Grubu T, Ö1 TBDMÖ T, Ö1, Ö2 

Kontrol Grubu T, Ö1 HÖ T, Ö1, Ö2 

Kısaltmalar: T: Akademik Başarı Testi; Ö1: Mobil Öğrenmeye Yönelik Tutum Ölçeği, Ö2: Animasyon 

Geliştirme Düzeyi Değerlendirme Ölçeği; TBDMÖ: Tablet Bilgisayar Destekli Mobil Öğrenme; HÖ: 

Harmanlanmış Öğrenme 

 

       Araştırmanın bağımlı değişkenleri akademik başarı, mobil öğrenmeye yönelik tutum 

ve animasyon geliştirme düzeyidir. Bağımsız değişkenleri ise harmanlanmış öğrenme ve 

tablet bilgisayar destekli mobil öğrenme uygulamasıdır. 

 

      Araştırmada harmanlanmış öğrenme, öğretim elemanı tarafından derslerin kuramsal 

ve uygulamalı olarak işlenmesi ve bu duruma ek olarak hazırlanan ders içeriklerinın web 
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destekli olarak öğrenme yönetim sistemi üzerinden öğrencilerin kullanımına 

sunulmasıyla gerçekleştirilmiştir. 

 

       Araştırmanın tablet bilgisayar destekli mobil öğrenme uygulamasında ise dersler 

öğretim elemanı tarafından kuramsal ve uygulamalı olarak işlenmiştir, fakat bu duruma 

ek olarak deney grubunda yer alan öğrencilere tablet bilgisayarlar dağıtılarak hazırlanan 

ders içeriklerine mobil cihazlar üzerinden erişimleri sağlanmıştır. 

 

        

Çalışma Grubu 

 

Araştırmanın çalışma grubunu 2013-2014 öğretim yılında Dokuz Eylül Üniversitesi 

Eğitim Fakültesi Bilgisayar ve Öğretim Teknolojileri Eğitimi Bölümü ikinci sınıfta 

öğrenim gören toplam 41 lisans öğrencisi oluşturmuştur. Çalışma grubuna ait demografik 

bilgilere Tablo 2’de yer verilmektedir.  
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Tablo 2 

Demografik Bilgiler 

  Deney Grubu Kontrol Grubu 

  n % n % 

Cinsiyet 
Kız 6 40 13 50 

Erkek 9 60 13 50 

Günlük 

Ortalama 

İnternet 

Kullanım Süresi 

Kullanmıyorum 0 0 0 0 

1-3 saat 1 7 11 42 

4-6 saat 9 60 12 46 

7 saat ve üstü 5 33 3 12 

Mobil Cihaz 

Sahipliği 

Cep telefonu 8 53 8 30 

Akıllı telefon 11 73 17 65 

Tablet bilgisayar 3 20 2 8 

Oyun konsolu, 

netbook, notebook  
8 53 15 58 

Mobil Cihaz ile 

Gerçekleştirilen 

İşlemler 

 

İletişim kurma 15 100 24 92 

Dosya paylaşma 12 80 21 80 

E-kitap okuma 8 53 7 27 

Araştırma yapma 9 60 20 77 

Oyun oynama 13 87 20 77 

Video izleme 12 80 21 80 

Müzik dinleme 15 100 25 96 

Alışveriş -Bankacılık 5 33 9 35 

E-öğrenme 7 47 11 42 

Podcast dinleme 0 0 3 12 

Mobil öğrenme 

ile ders işleme 

isteği 

Uygulamadan 

sonra 

Evet, sadece teorik 

derslerimde 
2 13 3 11 

Evet, sadece uygulama 

derslerimde 
6 40 7 27 

Evet, hem teorik hem 

uygulama derslerimde 
7 47 16 62 
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       Demografik bilgiler incelendiğinde araştırmada yer alan öğrencilerden deney 

grubundaki öğrencilerin %73’ü, kontrol grubundaki öğrencilerin ise %65’i akıllı telefona 

sahiptirler. Bu oranların yüksek olması öğrencilerin mobil cihazlarda yer alan 

uygulamalara aşina olduğunu ortaya koymaktadır. Bununla birlikte deney grubundaki 

öğrencilerin %20’si, kontrol grubundaki öğrencilerin ise %8’i tablet bilgisayara sahiptir. 

Bu oranların düşük olması öğrencilerin tablet bilgisayar kullanımı konusunda sıkıntılar 

yaşayabileceğini ortaya koymaktadır. Öğrenciler sahip oldukları mobil cihazlarla en az 

(deney grubu: %0, kontrol grubu: %12) podcast dinlediklerini, en çok müzik 

dinlediklerini (deney grubu: %100, kontrol grubu: %96) ve iletişim kurduklarını (deney 

grubu: %100, kontrol grubu: %92) belirtmişlerdir. Öğrencilerin hemen hemen yarısı 

(deney grubu: %47, kontrol grubu: %42) mobil cihazları aracılığıyla e-öğrenme 

gerçekleştirdiklerini belirtmişlerdir. Ayrıca deney grubu öğrencilerinin %47’si ve kontrol 

grubu öğrencilerinin %62’si hem kuramsal hem de uygulama derslerinde mobil öğrenme 

uygulamalarını kullanmak istediklerini belirtmişlerdir.  

 
 

Öğrenme Yönetim Sistemi Erişme Sayıları 

 

      Bu araştırmada öğrencilerin erişebilmeleri amacıyla Blackboard şirketi tarafından 

Blackboard öğrenme yönetimi sistemi altyapısı ile sunulan CourseSites platformunun 

kullanılması tercih edilmiştir.CourseSites sistemi ile ilgili ayrıntılı bilgiye “Öğrenme 

Ortamının Tasarlanması” bölümünde yer verilmiştir. Coursesites platformu öğrencilerin 

sistem kullanım istatistiklerini detaylı olarak raporlaştırarak kullanıcılarına 

sunabilmektedir. Bu raporlar bireysel, grup veya tüm öğrenciler için istenilen zaman 

dilimi aralığı belirtilerek alınabilmektedir. Deney ve kontrol grubundaki öğrencilerin 

günlere ve saatlere göre öğrenme yönetim sistemi erişim grafikleri Şekil 1 ve Şekil 2’de 

sunulmuştur. Mobil Cihazlar için Geçerli Kullanım Sözleşmesi öğrencilere 

imzalatılırken kullanım istatistiklerinin toplanmasına dair izin alınmıştır. Bu sayede 

öğrencilerin sistemi kullanmaları ve düzenli olarak erişmeleri sağlanmıştır. Eğitimde 

Grafik ve Canlandırma dersi dönem boyunca salı günleri saat 13:30 ile 17:00 arasında 

işlenmiştir. 
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Şekil 1. Günlere Göre Erişme Grafiği 

 

 

Şekil 2. Saatlere Göre Erişme Grafiği 

 
      Şekil 1 ve şekil 2 incelendiğinde, öğrencilerin sisteme en çok pazartesi ve cuma 

günleri erişim sağladıkları görülmektedir. Ayrıca, gün içerisinde en çok saat 13:00 

ve 14:00 arası erişim sağladıkları saptanmaktadır. Öğrencilerin ders dışı boş 

zamanlarında Coursesites platformunu daha yoğun kullandıkları söylenebilir. 
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Öğrenme Ortamının Tasarlanması 

 
Bu araştırma, Dokuz Eylül Üniversitesi tarafından 2013.KB.EGT.004 numaralı 

bilimsel araştırma projesi olarak kabul edilip desteklenmiştir.Bu proje kapsamında 15 

adet tablet bilgisayar satın alınmıştır. Tablet bilgisayar seçimi yapılırken birçok husus 

gözönünde bulundurulmuştur. Taşınabilirlik, ekran boyutu, işletim sistemi, 

kullanılabilirlik, batarya ömrü, fiyat ve kullanıcı dostu arayüze sahip olması gibi etkenler 

dikkate alınarak Samsung Galaxy Tab 3 cihazında karar kılınmıştır. Aynı özelliklere 

sahip diğer markalar arasından bu markanın seçilmesinin bir diğer nedeni de arka 

kameraya sahip olmasıdır. Gelecekte yapılacak artırılmış gerçeklik ve benzeri 

araştırmalarda arka kameraya ihtiyaç duyulacağı göz önünde bulundurulmuştur ve 

ilerideki olası farklı araştırmalarda düşünülerek bu cihaz alınmıştır. Cihaza ait teknik 

özellikler EK-12’de sunulmuştur. 

 
 

 
 

Şekil 3. Samsung Galaxy Tab 3 Tablet Bilgisayar 
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Tablet bilgisayarlar teslim alındıktan sonra öncelikle seri numaraları kaydedilerek 

liste haline getirilmiştir. İşletim sistemi versiyonları ve uygulamaların güncellemeleri 

kontrol edilerek en son güncellemeler yüklenmiştir ve öğrencilerin kullanımına hazır 

hale getirilmiştir. Kampus içerisinde öğrencilerin internete kolaylıkla bağlanabilmeleri 

için Eduroam ağına nasıl bağlanabileceklerini gösteren bir sunum hazırlanmıştır. 

Eduroam 54 ülkede yer alan eğitim kurumlarında kullanılan kablosuz olarak internete 

bağlanılabilen bir Wi-Fi ağıdır. Wi-Fi (wireless fidelity) radyo frekansı aracılığıyla 

kablosuz olarak verilerin iletimini gerçekleştiren kablosuz bağlantı alanıdır. Günümüzde 

yaygın olarak kullanılan akıllı telefon, tablet bilgisayar ve dizüstü bilgisayarlarda bu 

kablosuz bağlantı ağına bağlanarak internete bağlanabilmektedir (Cruz, Miranda ve 

Ribeiro, 2014; Jindal, Jindal ve Gupta, 2005). Öğrenciler Eduroam ağına öğrenci 

numarası ve şifreleri ile bağlanabilmektedir. Dokuz Eylül Üniversitesi Buca Eğitim 

Fakültesi internet altyapısı güçlü olmasına rağmen gün geçtikçe artan öğrenci sayılarıyla 

birlikte cihazlarda internete bağlanamama ve IP alamama gibi sorunlar görülmektedir. 

Projede yer alan öğrencilerin bu sorunları yaşamaması ve her an internete bağlı 

kalabilmeleri için Dokuz Eylül Üniversitesi Bilgi İşlem Dairesi Başkanlığı’na tablet 

bilgisayarların MAC adresleri (Ek 12) gönderilerek Eduroam ağına bağlanırken öncelik 

tanınması sağlanmıştır. Bu sayede öğrencilerin kampus içerisinde kolaylıkla internete 

bağlanabilmeleri hedeflenmiştir. Media Access Control (MAC) adresi her bir donanıma 

eşsiz bir adres oluşturmaya ve bu sayede bilgisayar ağının cihazı tanımasını 

sağlamaktadır (Limited, 2011). Ayrıca cihazların IMEI ve cihaz seri numaraları da 

alınarak daha sonra karşılaşılabilecek sorunlar için önlem alınması amaçlanmıştır.  

International Mobile Equipment Identity (IMEI) numarası her mobil cihaz için eşsiz bir 

tane olup tanınmasını sağlamaktadır (Scourias, 1995). Bu işlemlerden sonra deney 

grubundaki öğrencilere katılımlarını arttırmak, farkındalıklarını sağlamak, proje 

hakkında genel bilgi sahibi olmalarını sağlamak ve proje sürecinde tablet bilgisayarları 

nasıl kullanacaklarına ilişkin bir “Mobil Cihazlar için Geçerli Kullanım Sözleşmesi” 

hazırlanarak tablet bilgisayarlar teslim edilirken imzalatılmıştır (Ek 13). Ek 13’de yer 

alan sözleşmede öğrenciye ait kişisel bilgiler görünmeyecek şekilde değiştirilerek 

katılımcılara ait bilgilerin gizliliğin korunması hedeflenmiştir. “Mobil Cihazlar için 

Geçerli Kullanım Sözleşmesi” hazırlanırken Burden ve diğerleri (2012) tarafından 

İskoçya’da gerçekleştirilen proje kapsamında kullanılan Acceptable User Policy’den 

yararlanılmıştır. Tablet bilgisayarlar deney grubundaki öğrencilere dağıtılmıştır.  
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Öğrenme yönetim sistemlerine mobil cihazlarda yer alan web tarayıcılar aracılığıyla 

erişilebilir. Mobil cihazlarda yer alan web tarayıcıları yerel uygulamaların aksine 

donanım özelliklerine tam izinli erişim sağlayamamaktadır. Bu yüzden mobil web 

tarayıcıları aracılığıyla web üzerinden ders içerikleri görüntülenebilir fakat öğrenme 

içeriklerinin düzenli kayıt altına alınamaması, donanım ve yazılım özelliklerine kısıtlı 

erişim, öğrenme yönetim sistemlerinin kapsamlı özelliklerinin verimli kullanılamaması 

gibi sorunlar ortaya çıkmaktadır. Bu noktada çözüm web tabanlı öğrenme yönetim 

sistemlerine mobil cihazlardan erişimin kolaylaşması açısından yerel mobil 

uygulamalarının geliştirilmesidir. Birçok öğrenme yönetim sisteminin (Moodle, 

Edmodo, Blackboard, Schoology) yerel uygulamaları farklı mobil platformlar (Android, 

iOS, Palm, webOS, Blackberry) için geliştirilmiştir. Bu çalışmada Blackboard öğrenme 

yönetim sistemi tarafından hizmete sunulan CourseSites platformu tercih edilmiştir. 

CourseSites platformunun ücretsiz olması, farklı eklentileri bünyesinde barındırması, 

projede kullanılan Android işletim sistemine sahip cihazlarda verimli çalışması 

gözetilerek bu çalışmada tercih edilmiştir. Birçok öğrenme yönetim sisteminin mobil 

uygulamaları denenerek, kullanıcı dostu mobil arayüze sahip olması, farklı işletim 

sistemlerinde yerel dil ile geliştirilmiş uygulamalara sahip olması gibi etkenler de dikkate 

alınmıştır. Coursesites, Blackboard firması tarafından ücretsiz olarak kullanıcılara 

sunulan öğrenme yönetim sistemi platformudur. Kullanıcılar 5 adet derse kadar ücretsiz 

çevrimiçi kurslar oluşturabilir. Oluşturdukları bu kurslara öğrencilerini kayıt edebilir. 

Kayıtlı öğrencilerinin performanslarını değerlendirebilir ve platform üzerinden 

notlandırabilir. Coursesites platformunun en önemli özelliklerinden birisi farklı mobil 

platformlar (Android, iOS, Palm, webOS, Blackberry) için mobil uygulamalara sahip 

olması ve kullanıcılarına ücretsiz olarak sunmasıdır. Öğrenciler bu mobil uygulamalarla 

öğrenme yönetim sistemine erişebilmektedirler. Ayrıca öğretmenlerde mobil 

uygulamalar aracılığıyla bu kurs içeriklerini güncelleştirebilmekte, öğrencilerle 

etkileşimde bulunabilmekte, işbirliğini teşvik etmekte ve değerlendirmelerde 

bulunabilmektedir.  Coursesites platformu yönetim paneli sayesinde ders bağlamına 

uygun renkte temalar seçilebilmektedir. Coursesites platformu aracılığıyla yayımlanan 

ders içerikleri Creative Commons Attribution lisansı altında Açık Eğitim Kaynakları 

(Open Educational Resources) olarak yayımlanmaktadır. Creative Commons Attribution 

lisansı yazara atıfta bulunmak şartıyla başkalarının eğitim içeriğini dağıtmasına ve 
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düzenlemesine izin vermektedir (About the licences, 2013). Coursesites platformuna 

entegre oynatıcılarla birlikte videolar (youtube.com), slayt gösterileri (slideshare.com) 

ve fotoğraf galerileri (flickr.com) kaynakları sistem içerisinde kullanılabilmektedir. Kurs 

içeriği ve grup projeleri hakkında işbirliğini arttırma ve sosyal öğrenmeyi desteklemek 

amacıyla viki sayfaları oluşturulabilmektedir. Hızlı ve basit bir şekilde sınavlar 

oluşturulabilmekte ve notlandırma yapılabilmektedir. Coursesites anlık mesajlaşma 

(Coursesites Instant Messaging) modülü kullanılarak anlık etkileşim sağlanabilmektedir. 

Canlı Sınıf (Live Classroom) desteği ile öğrencilerin işbirliği olan çevrimiçi sınıflarda 

yazılı, sesli ve görsel olarak iletişim kurmalarını ve interaktif beyaztahta, uygulama ve 

masaüstü paylaşım seçenekleriyle etkileşimde bulunmalarına olanak sağlamaktadır. 

Merkezi dosya yönetim sistemi ile tüm içerikler tek bir noktadan güncellenebilmektedir. 

Öğretmenlere kişiselleştirilmiş web adresi vererek kendi sayfalarını oluşturmasına, bu 

sayede öğrencilerin öğretmenlere ve kurs içeriklerine kolay ulaşmasına imkan 

sağlamaktadır (Get The Most Powerful Tools, 2013).Blackboard öğrenme yönetim 

sisteminin CourseSites platformu ile sağladığı içerikler İngilizce dilinde olup, 

öğrencilerin daha kolay uyum sağlamaları açısından araştırmacı tarafından menüler ve 

içerikler Türkçe’ye uyarlanmıştır. 

 

Android uygulamalarını indirebildiğiniz Google Play Store’den Blackboard Mobile 

Learn uygulaması ücretsiz olarak indirilerek öğrencilere dağıtılmadan önce bütün tablet 

cihazlara yüklenmiştir. Bu uygulama sayesinde öğrenciler mobil cihazlarından ders 

içeriklerine erişebilecek ve diğer bütün özellikleri de kullanabileceklerdir. 

 

       Dokuz Eylül Üniversitesi Bilgi İşlem Dairesi Başkanlığı tarafından temin edilen 

lisanslı sürüm Adobe Flash Professional CS6 programı, ders dönemi başlamadan önce 

öğretimin gerçekleştirileceği her iki laboratuara yükletilmiştir. Eğitimde Grafik ve 

Canlandırma dersi kazanımlarına Dokuz Eylül Üniversitesi Bilgi Paketi Ders Kataloğu 

sitesinden erişilmiştir. Bu noktada diğer üniversitelerde de verilen bu dersin 

kazanımlarına erişilmiş ve karşılaştırılmış, ders kazanımlarının üniversitelerde farklı 

olduğunun anlaşılması üzerine araştırmanın gerçekleştirileceği üniversitedeki 

kazanımlara göre içerik hazırlanmasına karar verilmiştir. Eğitimde Grafik ve 

Canlandırma dersi kazanımları gözönünde bulundurularak araştırmacı tarafından ilgili 

kazanım ve amaçlar doğrultusunda içerikler geliştirilmiştir. Bu içerikler geliştirilirken 
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alan uzmanlarının görüşlerine başvurularak içerik uygunluğu ve konu bütünlüğünü 

ilgilendiren gerekli düzeltmeler yapılmıştır. İçerikler geliştirilirken Adobe Flash CS6 

Professional, Articulate, Adobe Acrobat Pro, Adobe Edge Animate yazılımları 

kullanılmıştır. Android işletim sistemi Flash içeriği desteklemesine ragmen, tablet 

bilgisayarlarda karşılaşılan içerik gösterimi sorunları nedeniyle aynı animasyonlar 

HTML5 olarak geliştirilmiştir. Bu sayede karşılaşılabilecek uyum sorunlarının ortadan 

kaldırılması hedeflenmiştir.  

 

       Deney grubu için dersler öğretim elemanı tarafından teorik ve uygulamalı olarak 

işlenmiştir. Bu duruma ek olarak deney grubunda yer alan öğrencilerin her birine tablet 

bilgisayarlar dağıtılmış ve hazırlanan ders içeriklerine mobil cihazlar üzerinden 

erişmeleri sağlanmıştır. Kontrol grubu için de dersler öğretim elemanı tarafından teorik 

ve uygulamalı olarak işlenmiştir. Bu duruma ek olarak ders içerikleri web destekli olarak 

https://deu.coursesites.com/ web sitesi üzerinden öğrencilerin kullanımına sunulmuştur. 

Deney grubu öğrencilerinin mobil cihazlardan erişebildikleri örnek ekran görüntüleri 

Şekil 4’ de sunulmuştur. Kontrol grubu öğrencilerinin örnek ekran görüntüleri Şekil 5’ 

de sunulmuştur. Ayrıca ders öğretmeni de her iki ortam üzerinden sistemi 

kullanabilmektedir. Öğretmen yetkisine sahip kullanıcı bu sistem üzerinden yeni ders 

içerikleri yükleyebilmekte, ödevler verebilmekte, forum ve blog konuları açabilmekte, 

öğrenciler tarafından sorulan sorulara cevap verebilmekte, öğrencilere bireysel veya grup 

olarak mesaj, multimedia içerik paylaşabilmekte, e-posta gönderebilmekte ve duyuru 

yapabilmektedir. 

 

 
 

https://deu.coursesites.com/
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Şekil 4. Mobil Cihazlardan Erişilen Coursesites Platformu İçerik Görüntüleri 

 

 

 

 
 

Şekil 5. Kontrol Grubu Tarafından Erişilen Coursesites Platformu İçerik Görüntüleri 
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Veri Toplama Araçları 

 

Akademik Başarı Testi 

Katılımcıların Eğitimde Grafik ve Canlandırma dersindeki başarılarını ölçmek ve 

karşılaştırmak amacıyla araştırmacı tarafından geliştirilmiştir. Bu kapsamda dersin 

kazanımları gözönünde bulundurulmuştur. Test geliştirilmeden önce konu kapsamı, 

hedefler ve içerik oluşturulmuştur. Alan uzmanlarından alınan görüşler doğrultusunda 36 

adet soru hazırlanmış ve analizleri için ön uygulama yapılmıştır. Testin geliştirilmesi 

aşamasında belirtke tablosu (EK 8) oluşturulmuştur. Madde analizinin yapılabilmesi için 

daha önce Eğitimde Grafik ve Canlandırma dersi almış Anadolu Üniversitesi Bilgisayar 

ve Öğretim Teknolojileri bölümü lisans öğrencisi 61 kişi ve Dokuz Eylül Üniversitesi 

Bilgisayar ve Öğretim Teknolojileri bölümü öğrencisi 89 kişi olmak üzere toplam 150 

kişiye test uygulanmıştır. Tüm cevaplar elde edildikten sonra TAP (Test Analysis 

Program) yazılımı ile madde güçlüğünü ve madde ayırdediciliğini hesaplamak için 

gerekli analizler yapılmıştır. 36 maddelik testin madde güçlüğü, ayırdediciliği, üst grup-

alt grup istatistikleri ve madde toplam puan korelasyonu hesaplanmıştır.  Madde güçlüğü, 

bir test çalışmasında doğru olarak cevaplanan soruların tüm katılımcıların sayısına 

oranını vermekte, madde 1,00 değerine yakınlaştıkça kolay, ,00 değerine yakınlaştıkça 

zor olarak kabul edilmektedir. Madde ayırdedicilik gücü indeksi ilgili özelliğe sahip olan 

madde ile olmayan maddeyi ayırt etmeye yarar (Alpar, 2012) Ayırt ediciliği; 0,40’tan 

yüksek maddeler çok iyi, 0,30-0,40 arası olan maddeler iyi, 0,20-0,30 arası olan maddeler 

ise kullanılabilir olarak kabul edilmektedir (Alpar, 2012; Özçelik, 2013). Bu özelliklere 

uymayan 13 madde (2, 3, 4, 7, 8, 9, 10, 21, 24, 29, 30, 32, 35) testten çıkarılmıştır.Yapılan 

analiz sonuçları Tablo 3’te sunulmuştur. 
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Tablo 3 

 
Eğitimde Grafik ve Canlandırma Dersi Başarı Testi Analiz Sonuçları 

 

Soru 

Numarası 

Madde 

Güçlüğü 

Madde 

Ayırıcılık Gücü 

İndeksi 

1. Soru 0,80 0,33 

5. Soru 0,86 0,23 

6. Soru 0,35 0,58 

11. Soru 0,79 0,54 

12. Soru 0,62 0,58 

13. Soru 0,72 0,37 

14. Soru 0,40 0,50 

15. Soru 0,72 0,54 

16. Soru 0,89 0,29 

17. Soru 0,63 0,67 

18. Soru 0,56 0,62 

19. Soru 0,50 0,63 

20. Soru 0,80 0,52 

22. Soru 0,64 0,48 

23. Soru 0,49 0,47 

25. Soru 0,65 0,44 

26. Soru 0,87 0,41 

27. Soru 0,73 0,43 

28. Soru 0,43 0,54 

31. Soru 0,56 0,49 

33. Soru 0,70 0,56 

34. Soru 0,60 0,56 

36. Soru 0,50 0,51 

 

23 madddeden oluşan testin KR-20 güvenirlik katsayısı 0,83 olarak bulunmuştur. 

KR -20 katsayısı güvenirliğin belirlenmesi için kullanılmaktadır (Alpar, 2012). KR-20 

katsayısının 1’e yakın olması testin güvenilir olduğunu göstermektedir. Testin madde 
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ayırt ediciliği 0, 49, madde güçlüğü ise 0, 64’dur. Başarı testinin23 maddelik son hali 

EK3’de sunulmuştur. 

 

 

Mobil Öğrenmeye Yönelik Tutum Ölçeği 

 

Ölçek geliştirme sürecinde ilk olarak mobil öğrenme özellikleri, mobil öğrenmeye 

karşı tutum ölçekleri ve mobil öğrenmeye karşı tutum odaklı bir alanyazın taraması 

gerçekleştirilmiştir (Al-Fahad, 2009; Corlett, Sharples, Bull, ve Chan, 2005; Çelik, 2013; 

Liaw, 2008; Wang, 2007). Etik kurul izni alındıktan sonra, alan uzmanlarının görüşü 

alınarak hazırlanan yedi adet açık uçlu sorudan oluşan görüş alma formu (Ek 6) taslak 

madde havuzu oluşturmak amacıyla Dokuz Eylül Üniversitesi Buca Eğitim Fakültesi 

BÖTE Bölümü’nde öğrenim görmekte olan 78 lisans öğrencisinden bilgi toplanmıştır. 

Öğrencilerden toplanan veriler analiz edilerek tutum ifadeleri ortaya çıkartılmıştır. Bu 

noktada 57 maddelik bir taslak oluşturulmuştur.  

 

Taslak halindeki ölçek uzman görüşlerine başvurulması amacıyla çeşitli 

üniversitelerde alan uzmanı olarak görev yapan öğretim elemanlarına gönderilmiştir. 

Uzmanların görüş ve önerileri doğrultusunda uygun olmayan maddeler ve birbirine 

benzer maddeler ölçekten çıkarılmıştır. Yapılan düzeltmelerden ölçeğin son hali 41’i 

olumlu 11’i olumsuz 52 maddeden oluşmuştur. Oluşturulan maddeler beşli likert tipinde 

olup, tamamen katılıyorum (5), katılıyorum (4), kısmen katılıyorum (3), katılmıyorum 

(2), tamamen katılmıyorum (1) şeklinde derecelendirilmiştir. Her bir maddeden alınan 

puanlar toplanarak ölçek toplam puanları hesaplanmıştır. Bir öğrenci ölçekten en düşük 

52 en fazla 260 puan alabilmektedir. 

  

Faktör analizi yapılabilmesi için Kaiser Meyer-Olkin (KMO) ve Bartlett küresellik 

testi yapılması gerekmektedir. Yapılan analizler sonucunda KMO değeri 0,94 

bulunmuştur. Bu değer çok iyi olarak kabul edilmektedir. Bartlett testi ise anlamlı 

bulunmuştur (χ2=8530,19; p<,000).  Elde edilen bu veriler ışığında ölçeğin faktör 

analizine uygun olduğuna karar verilmiştir. Birinci faktör analizinden elde edilen verilere 
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göre özdeğeri 1,00’in üzerinde yer alan 10 faktör altında ölçek puanlarındaki varyansın 

%65, 32’sı açıklanmaktadır. 

 
 
 
 

 
 

Şekil 6. Özdeğer Faktör Grafiği 

 
 

Uygulanan faktör analizi ile ölçeğin son haline karar verilmiştir. Ölçek 45 maddeden 

oluşmaktadır. Ölçeğin son halinin Cronbach Alfa güvenirlik katsayısı 0,95 olarak 

hesaplanmıştır. Yapılan analizler sonucunda KMO değeri 0,93 bulunmuştur. Bartlett testi 

ise anlamlı bulunmuştur (χ2=7820,10; p<,000).  Üçüncü faktör analizinden elde edilen 

verilere göre 4 faktör altında 45 maddeden oluşmaktadır ve bu 4 faktör ölçek 

puanlarındaki varyansın %50,34’ini açıklamaktadır. Faktör isimleri olarak Memnuniyet 

(Faktör 1), Öğrenmeye Etkisi (Faktör 2), Motivasyon (Faktör 3) ve Kullanışlılık (Faktör 

4) belirlenmiştir.  Faktörlerin belirlenmesi amacıyla literatürde yer mobil öğrenmeye 

yönelik tutum çalışmaları ve faktör yapıları incelenmiştir (Al-Fahad, 2009; Corlett, 

Sharples, Bull, ve Chan, 2005; Çelik, 2013; Liaw, 2008; Wang, 2007). Daha sonra iki 

adet alan uzmanı ile görüşülüp faktörler altında yer alan maddeler tartışılarak faktör 
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isimlerine karar verilmiştir. Ölçeğin son hali üzerinden bir öğrenci en düşük 45 en fazla 

225 puan alabilmektedir. Ölçeğin son hali Ek 2’de sunulmuştur. 

 

      Faktörler incelendiğinde her faktörün iç tutarlılık katsayısının yüksek çıktığı 

görülmektedir. Ayrıca ölçeğin 45 maddeden oluşan son halinin iç tutarlılık katsayısı ,950 

olarak bulunmuştur.  

 
Tablo 4 

 
Güvenirlik Analizi Sonuçları 

 
Faktör N Cronbach's Alpha 

Faktör 1 20 ,942 

Faktör 2 11 ,877 

Faktör 3 7 ,886 

Faktör 4 7 ,776 

Toplam 45 ,950 

 

 

     Tabloda görülen Pearson Korelasyon katsayılarından anlaşıldığı üzere faktörlerin 

birbirleriyle ve ölçek toplam puanıyla aralarındaki ilişki, p<0.01 düzeyinde anlamlı 

bulunmuştur. 

 

 

Öğrenci Ürünleri 

 
      Araştırmada uygulama sonunda deney ve kontrol gruplarından ders kazanımlarını 

içerisinde barındıran bir animasyon geliştirmeleri istenmiştir. Animasyonu geliştirirken 

düzenli çalışılmasına ve grafik ve animasyonların birbiri ile uyum içerisinde olmasına 

dikkat etmeleri istenmiştir. Animasyonu geliştirebilmeleri için öğrencilere 90 dakika süre 

verilmiştir. Geliştirilen animasyonlar araştırmacı tarafından toplanmıştır. Araştırmanın 

geçerliğini yükseltmek amacıyla, araştırma problemi ile ilgili görsel materyaller 

doküman analizi yöntemi ile incelenebilmektedir (Yıldırım ve Şimşek, 2011). Toplanan 

animasyonlar doküman analizine tabi tutulmuştur. 
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Denel İşlemler 

 
 

 
 

 

 

Verilerin Çözümlenmesi ve Analizi 

 
Araştırmada deney grubu 15 ve kontrol grubu ise 26 kişiden oluşmaktadur. 

Alanyazın incelendiğinde ise örneklem sayısı 30 kişiden fazla olduğunda parametrik 

testler uygulanabileceği söylenmektedir. Normal dağılımın sağlandığı fakat örneklemin 

30 kişiden az olduğu durumlarda da parametrik testlerin uygulanabileceği 

belirtilmektedir (Akbulut, 2010). Bu durumda bu çalışmada normal dağılımlar ve 

homojenlik gözetilerek parametrik ve parametrik olmayan testlerin bir arada kullanılması 

tercih edilmiştir.Deney grubu ve kontrol grubuna ön test ve son test olarak uygulanan test 

ve ölçekten elde edilen veriler analiz edilerek, öğrencilerin puan ortalamaları 

hesaplanmıştır. Bu araştırmada deney grubu 15 öğrenciden, kontrol grubu ise 26 

öğrenciden oluşmaktadır. Çarpıklık (skewness), basıklık (kurtosis) değerleri ve 

histogram grafiği başarı testi sonuçlarının normal dağılım göstermediğini işaret 
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etmektedir. Bu bulgular ışığında başarı testi ile ilgili karşılaştırmalar yapılırken 

parametrik olmayan testlerin kullanılmasına karar verilmiştir. Tutum ölçeği sonuçları 

normal dağılım gösterdiğinden dolayı karşılaştırmalar yapılırken parametrik testler 

kullanılmıştır. Araştırmada uygulama sonunda deney ve kontrol gruplarından ders 

kazanımlarını içerisinde barındıran bir animasyon geliştirmeleri istenmiştir. Geliştirilen 

animasyonlar araştırmacı tarafından toplanmıştır. Oluşturulan içerikler alan uzmanı ve 

araştırmacı tarafından Animasyon Geliştirme Düzeyi Dereceli Puanlama Anahtarı 

kullanılarak (EK-5) ayrı ayrı puanlanmıştır. Alan uzmanı ve araştırmacı daha sonra bir 

araya gelerek puanları karşılaştırmış ve farklı puan verdikleri maddeleri tartışarak ortak 

karara ulaşmışlardır. Öğrenciler tarafından geliştirilen animasyonlar analiz edilmiştir.  
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BÖLÜM IV 
 
 

BULGULAR VE YORUMLAR 
 
 

Bu bölümde uygulamadan önce ve sonra yöntemde belirtilen veri toplama araçları 

ile toplanan verilerin, yöntem bölümünde belirtilen tekniklerle analizi sonucu elde edilen 

bulgulara yer verilmiştir. Araştırmanın problemi ışığında oluşturulan alt problemlere 

göre bulgular gruplandırılmış ve yorumlanmıştır. 

 

 

Birinci alt probleme ait bulgular 

 

Birinci alt problem “Bilgisayar ve Öğretim Teknolojileri Eğitimi (BÖTE) 

Bölümü Grafik ve Animasyon dersinde mobil öğrenme uygulamaları ile öğrenim 

gören öğrenciler ile normal öğretim ile öğrenim gören öğrencilerin akademik 

başarıları arasında anlamlı bir fark var mıdır?” olarak belirlenmiştir. Bu amaçla 

kullanılan başarı testi 23 sorudan oluşmaktadır. Doğru cevaplar 1 puan değerinde iken 

yanlış cevaplara 0 puan verilmiştir. Başarı testinden alınabilecek en yüksek puan 23’tür.  

 

Tablo 5  

Deney ve Kontrol Gruplarının Ön Test - Son Test Başarı Puanlarının Karşılaştırılması 

 

Grup Test n 
Sıralar 

Ortalaması 

Sıralar 

Toplamı 

Mann-

Whitney U 
Z p 

Deney 
Ön test 

15 25.20 378.00 
132.000 -1.716 .086 

Kontrol 26 18.58 483.00 

Deney 
Son test 

15 31.13 467.00 
43.000 -4.150 .000 

Kontrol 26 15.15 394.00 
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Deney ve kontrol grupları arasında Mann-Whitney U testine ilişkin Tablo 6’de yer 

alan bulgular incelendiğinde; uygulama öncesinde deney grubunun ön test ortalaması ile 

kontrol grubunun ön test ortalaması arasında anlamlı bir farklılığın olmadığı 

gözlenmektedir (p>.05). Uygulama sonrasında ise deney grubu lehine anlamlı farklılığın 

ortaya çıktığı görülmektedir (p<.05). Buna göre tablet bilgisayar destekli mobil öğrenme 

yöntemi ile gerçekleştirilen öğrenmenin harmanlanmış öğrenmeye göre akademik başarı 

açısından olumlu yönde anlamlı bir fark yarattığı söylenebilir. 

 

Tablo 6  

Deney ve Kontrol Gruplarının Kendi İçerisinde Ön Test - Son Test Başarı Puanlarının 

Karşılaştırılması 

 

Gruplar Test n 
Sıralar 

Ortalaması 

Sıralar 

Toplamı 

Mann-

Whitney U 
Z p 

Deney 

Ön 

test 
15 8.00 120.00 

.000 -4.696 .000 
Son 

test 
15 23.00 345.00 

Kontrol 

Ön 

test 
26 14.98 389.50 

38.500 -5.497 .000 
Son 

test 
26 38.02 988.50 

 
 

Deney ve kontrol gruplarının kendi içerisinde Mann-Whitney U testine ilişkin Tablo 

6’de yer alan bulgular incelendiğinde; deney grubu öğrencilerinin uygulama öncesi 

başarı testi puanlarına göre uygulama sonrası başarı testi puanlarının anlamlı bir şekilde 

arttığı ortaya çıkmaktadır. Bu sonuç tablet bilgisayar destekli mobil öğrenme yöntemi ile 

gerçekleştirilen öğrenmenin öğrencilerin öğrenmelerine olumlu bir etki yaptığını ortaya 

çıkartmıştır.  

Kontrol grubu öğrencilerinin de uygulama öncesi başarı testi puanlarına göre 

uygulama sonrası başarı testi puanlarının anlamlı bir şekilde arttığı ortaya çıktığı 

görülmektedir. Kontrol grubunda gerçekleştirilen harmanlanmış öğrenme yönteminin de 

kontrol grubunun başarısına olumlu etki yaptığı görülmektedir. 
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İkinci alt probleme ait bulgular 

İkinci alt problem “Bilgisayar ve Öğretim Teknolojileri Eğitimi (BÖTE) Bölümü 

Grafik ve Animasyon dersinde mobil öğrenme uygulamaları ile öğrenim gören 

öğrenciler ile normal öğretim ile öğrenim gören öğrencilerin animasyon geliştirme 

düzeyleri arasında anlamlı bir fark var mıdır?” olarak belirlenmiştir. 

 

Animasyonlar analiz bölümünde belirtilen işlem adımları kullanılarak analiz edilerek 

puanlanmıştır. Analiz sonuçları Tablo 7’de yer almaktadır.  

 

Tablo 7 

Deney ve Kontrol Gruplarının Animasyon Geliştirme Düzeyi Dereceli Puanlama 

Anahtarı Puanlarının Karşılaştırılması 

 

Gruplar n 
Sıralar 

Ortalaması 

Sıralar 

Toplamı 

Mann-

Whitney U 
Z p 

Deney 15 30.97 464.50 

45.500 -4.096 .000 

Kontrol 26 15.25 396.50 

 

 
       Tablo 7’de yer alan değerler incelendiğinde geliştirilmiş olan içeriklerin nitelikleri 

konusunda deney grubu lehine anlamlı farklılığın ortaya çıktığı görülmektedir (p<.05). 

Ortaya çıkan bu sonuç başarı testi son test sonuçları ile paralellik göstermektedir. 
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Şekil 7. Öğrenci Ürünleri Örnek Ekran Görüntüsü 

 
 
 

Üçüncü alt probleme ait bulgular 

Üçüncü alt problem “Bilgisayar ve Öğretim Teknolojileri Eğitimi (BÖTE) 

Bölümü Grafik ve Animasyon dersinde mobil öğrenme uygulamaları ile öğrenim 

gören öğrenciler ile normal öğretim ile öğrenim gören öğrencilerin mobil 

öğrenmeye yönelik tutumları arasında anlamlı bir fark var mıdır?” olarak 

belirlenmiştir. Bu doğrultuda araştırmacı tarafından geliştirilen Mobil Öğrenmeye 

Yönelik Tutum Ölçeği dört faktör altında toplam 45 maddeden oluşmaktadır. Ölçeğe ait 

faktörler ve bu faktörlere ait madde sayıları Tablo 8’de gösterilmiştir. 

 

Tablo 83  

Mobil Öğrenmeye Yönelik Tutum Ölçeği Faktörlere Ait Madde Sayıları ve Puanlama 

 
Faktör Adı Madde Sayısı En Düşük 

Puan 

En Yüksek 

Puan 

Memnuniyet 20 20 100 

Öğrenmeye Etkisi 11 11 55 

Motivasyon 7 7 35 

Kullanışlılık 7 7 35 
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Tablo 9  

Deney ve Kontrol Gruplarının Ön Test - Son Test Mobil Öğrenmeye Yönelik Tutum 

Ölçeği Puanlarının Karşılaştırılması 

 
 

Faktör Gruplar Test n X SS t p 

M
em

n
u

n
iy

et
 Deney 

Ön Test 
15 74.13 9.72 

.754 .528 
Kontrol 26 76.38 11.52 

Deney 
Son Test 

15 70.80 12.42 
-.841 .405 

Kontrol 26 74.00 11.33 

Ö
ğ
re

n
m

ey
e 

E
tk

is
i 

Deney 
Ön Test 

15 42.40 8.08 
-.079 .206 

Kontrol 26 45.38 6.60 

Deney 
Son Test 

15 42.60 5.84 
-1.153 .256 

Kontrol 26 44.77 5.78 

M
o
ti

v
a
sy

o
n

 Deney 
Ön Test 

15 26.00 3.93 
-.868 -.722 

Kontrol 26 26.46 3.99 

Deney 
Son Test 

15 24.67 5.27 
-1.204 .236 

Kontrol 26 26.50 4.34 

K
u

ll
a
n

ış
lı

lı
k

 Deney 
Ön Test 

15 24.40 3.16 
-1.369 .091 

Kontrol 26 22.04 5.56 

Deney 
Son Test 

15 22.47 4.45 
.838 .407 

Kontrol 26 21.08 5.45 

 
 

 

Tablo 9 incelendiğinde, deney ve kontrol gruplarının tüm faktörlere yönelik 

tutum puanlarının ön test son test sonuçları arasında anlamlı bir farklılık bulunamamıştır 

(p>.05).  
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Tablo 40  

Deney ve Kontrol Gruplarının Kendi İçerisinde Ön Test - Son Test Mobil Öğrenmeye 

Yönelik Tutum Ölçeği Puanlarının Karşılaştırılması 

 

Faktör Gruplar Test n X SS T p 

M
em

n
u

n
iy

et
 

Deney 
Ön Test 15 74,13 9,72 

,754 ,463 
Son Test 15 70,80 12,42 

Kontrol 

 

Ön Test 26 76,38 11,52 
,708 ,486 

Son Test 26 74,00 11,33 

Ö
ğ
re

n
m

ey
e 

E
tk

is
i 

Deney 
Ön Test 15 42,40 8,08 

-,079 ,938 
Son Test 15 42,60 5,84 

Kontrol 

 

Ön Test 26 45,38 6,60 
,364 ,719 

Son Test 26 44,77 5,78 

M
o
ti

v
a
sy

o
n

 

Deney 
Ön Test 15 26,00 3,93 

-,868 ,400 
Son Test 15 24,67 5,27 

Kontrol 

 

Ön Test 26 26,46 3,99 
-,030 ,976 

Son Test 26 26,50 4,34 

K
u

ll
a
n

ış
lı

lı
k

 

Deney 
Ön Test 15 24,40 3,16 

-1,369 ,193 
Son Test 15 22,47 4,45 

Kontrol 

 

Ön Test 26 22,04 5,56 
,581 ,567 

Son Test 26 21,08 5,45 

 

 
 

Tablo 10 incelendiğinde, deney ve kontrol gruplarının kendi içerisinde ön test ve 

son test puanları arasında anlamlı bir farklılığın olmadığı görülmektedir (p>.05). Bu 

tabloda da ön test sonuçlarının aritmetik olarak yüksek olması deney ve kontrol grubu 

arasında son test sonucunda anlamlı bir fark oluşmamasına yol açmaktadır. Bu noktada 

daha önce belirtildiği gibi öğrencilerin Bilgisayar ve Öğretim Teknolojileri Eğitimi 

bölümünde okumaları, teknolojik okuryazarlık seviyelerinin yüksek olması, teknolojiye 

karşı olumlu tutumları anlamlı farkın oluşmamasında etkili olduğu söylenebilir. 
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BÖLÜM V 
 
 
 

SONUÇ, TARTIŞMA VE ÖNERİLER 
 

 

 
      Bu araştırmada grafik ve animasyon dersindeki mobil öğrenme uygulamalarının 

öğrencilerin akademik başarılarına ve mobil öğrenmeye yönelik tutumlarına etkisi ve 

mobil öğrenme uygulamalarının öğrencilerin animasyon geliştirme becerileri üzerindeki 

etkisi araştırılmıştır. Aşağıda elde edilen bulguların ilgili literatür ışığında sonuç, tartışma 

ve önerilere yer verilmiştir. 

 

      Başarı testi sonuçları incelendiğinde deney grubunun ön test ortalaması ile kontrol 

grubunun ön test ortalaması arasında anlamlı bir farklılığın olmadığı görülmüştür. Son 

testlerde ise deney grubu lehine anlamlı farklılığın ortaya çıktığı görülmüştür. Buna göre 

tablet bilgisayar destekli mobil öğrenme yöntemi ile gerçekleştirilen öğrenmenin 

harmanlanmış öğretime göre akademik başarı açısından deney grubu lehine daha olumlu 

etki oluşturduğu ortaya çıkmıştır. Gruplar kendi içerisinde karşılaştırıldığında ise her iki 

gruptada son testler lehine anlamlı fark bulunmuştur. Oberer ve Erkollar (2013) 

araştırmalarında mobil öğrenme sayesinde öğrencilerin daha iyi sonuçlar elde ettikleri 

sonuçlarına ulaşmışlardır. Hwang ve Chang (2011) mobil öğrenmenin sadece 

öğrencilerin ilgisini çekmekle kalmadığını, bununla birlikte başarılarını arttırdığı 

sonucuna ulaşmışlardır. Bunun aksine Chu (2014) araştırmasında aşırı bilişsel yük ve 

uygunsuz öğrenme tasarımı yüzünden mobil öğrenmenin akademik başarıyı olumsuz 

etkileyebileceğini ifade etmişir. Bu araştırmada Oberer ve Erkollar (2013), Hwang ve 

Chang (2011)’ın elde ettiği sonuçlara paralel olarak tablet bilgisayar destekli mobil 

öğrenme yönteminin normal öğretim yöntemine göre öğrencilerin akademik başarıları 

üzerinde deney grubu lehine etkisinin daha fazla olduğu görülmüştür. Görüldüğü üzere, 

tablet bilgisayar destekli mobil öğrenmenin akademik başarı üzerinde olumlu ve olumsuz 

etkilerinin ortaya çıkartıldığı çeşitli çalışmalar bulunmaktadır. Bu çalışmada da tablet 
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bilgisayar destekli öğrenmenin deney grubu lehine olumlu sonuç verdiği görülmüştür. 

Bununla birlikte tablet bilgisayar destekli mobil öğrenme çalışmalarının 

yaygınlaştırılması, farklı öğretim kademelerinde, farklı derslerde uygulanması ve etkileri 

araştırılabilir.  

 

      Mobil Öğrenmeye Yönelik Tutum Ölçeği sonuçları her iki grup için dikkate 

alındığında, deney ve kontrol gruplarının ön test ve son test puanları arasında anlamlı bir 

farklılığın olmadığı görülmektedir. Ayrıca deney ve kontrol gruplarının kendi içerisinde 

ön test ve son test puanları arasında da anlamlı bir farklılığın olmadığı görülmektedir. Bu 

noktada birden fazla etkenden bahsedilebilir. Deney grubu ve kontrol grubu ön test ve 

son test puanlarının aritmetik olarak oldukça yüksek olduğu görülmüştür. Öğrencilerle 

araştırma öncesinde yapılan görüşmelerden elde edilen bulgularda, öğrencilerin mobil 

öğrenmenin tanımını bildikleri ve olumlu tutuma sahip oldukları araştırmacı tarafından 

görülmüştür. Deney grubunda yer alan öğrenciler ile yapılan görüşmelerde elde edilen 

bulgularda öğrencilerin mobil öğrenme hakkında uygulama öncesinde de bilgi sahibi 

olduklarını göstermektedir. Bu duruma sebep olarak öğrencilerin BÖTE bölümünde 

lisans öğrenimi görmeleri, teknoloji okuryazarlık seviyelerinin diğer bölümlere göre 

yüksek olabileceği, mobil teknolojilere karşı olumlu tutumlara sahip olabilecekleri 

söylenilebilir. Chu ve ark. (2010)’da yaptıkları deneysel çalışma sonucunda öğrencilerin 

mobil öğrenmeye karşı olumlu tutum içinde oldukları sonucuna varmışlardır. Köse, Koç, 

ve Yücesoy (2013)’da gerçekleştirdikleri deneysel çalışma sonucunda mobil öğrenmenin 

diğer e-öğrenme araçlarına yaklaşımlarına göre öğrenciler tarafından daha iyi ve 

eğlenceli kabul edildiğini ifade etmiştir. Hwang ve Chang (2011)’da mobil öğrenmenin 

öğrenci başarısını olumlu yönde etkilediğine ulaşmışlardır. Bununla birlikte Evans’ın 

(2008), Gikas ve Grant’in (2013), Kutluk ve Gülmez’in (2014), Oberer ve Erkollar’ın 

(2013) da araştırmasında ulaştığı sonuçlara benzer olarak bu araştırmada da öğrencilerin 

mobil öğrenmeye yönelik tutumlarının olumlu olduğu görülmektedir. Bu sonuçlardan 

yola çıkılarak, öğrencilerin mobil öğrenmeye karşı olumlu tutumları sayesinde, başarılı 

olmadıkları ve ilgilenmedikleri dersler için mobil öğrenme yaklaşımı kullanılarak bu 

derslere karşı da olumlu tutum geliştirmeleri sağlanabilir.  

 

       Uygulama sonunda öğrenciler tarafından geliştirilen animasyonlar araştırmacı 

tarafından toplanmıştır. “Animasyon Geliştirme Düzeyi Dereceli Puanlama Anahtarı” 
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(EK 5) kullanılarak öğrenciler tarafından geliştirilen ürünler değerlendirilmiştir. Deney 

grubu öğrencileri tarafından oluşturulan içeriklerin kontrol grubu tarafından oluşturulan 

içeriklere göre anlamlı derecede farklı olduğu bulunmuştur. Ortaya çıkan bu sonuç 

akademik başarı testinde elde edilen bulgular ile de paralellik göstermektedir. Ozan 

(2013) araştırmasında mobil teknolojilerin kullanımının öğrenci performanslarını olumlu 

etkilediği sonucuna ulaşmıştır. Huang ve ark. (2014)’da mobil öğrenmenin öğrenme 

etkililiğini arttırdığı sonucuna varmışlardır. Oberer ve Erkollar (2013)’da araştırma 

sonuçlarında mobil öğrenmenin öğrencilerin projelerinden daha yüksek sonuçlar 

almalarını sağladığını ortaya çıkarmıştır. Bununla birlitke bu araştırma da Ozan (2013), 

Huang ve ark. (2014) ve Oberer ve Erkollar (2013)’ın araştırmasında ulaştığı sonuçları 

destekler niteliktedir. Elde edilen sonuçlardan yola çıkılarak, önümüzdeki dönemlerde 

proje, materyal vb. ürünlerin öğrenciler tarafında geliştirileceği derslerde mobil öğrenme 

kullanılmalı ve etkileri incelenmelidir. 

 

      Ayrıca, öneri olarak şunlar sunulmaktadır. Bu araştırmada geliştirilen mobil cihazlara 

yönelik öğrenme içeriklerin farklı ders ve konulara yönelik olarak hazırlanması ve 

etkililiğinin araştırılması gerekir. Okullarda yapılacak uygulamalar için okulların gerekli 

kablosuz internet ihtiyaçlarının giderilmesi gerekmektedir. Bu araştırmada 

gerçekleştirilen uygulamalar Eğitimde Grafik ve Canlandırma dersine yönelik olarak 

hazırlanmıştır.  Bu türde uygulamaların diğer dersler için de hazırlanması ve uygulanması 

gerekir. 

       Ayrıca araştırmacı tarafından aşağıdaki önerilerde bulunulmuştur:       

 Araştırma kapsamında sınırlı sayıda mobil cihaz kullanılmıştır. Bundan sonra 

yapılacak araştırmalarda fazla sayıda mobil cihazlar kullanılarak daha geniş bir 

çalışma grubuyla mobil uygulamaların etkililiği araştırılabilir. 

 

 Araştırmada kullanılan mobil cihazlar Android işletim sistemine sahiptir. Farklı 

işletim sistemlerine sahip mobil cihazlar kullanılarak araştırmalar yapılabilir. 

 

 Bu çalışma Dokuz Eylül Üniversitesi BÖTE bölümünde iki şube ile sınırlıdır. 

Diğer üniversitelerde aynı programlarda uygulanarak geniş örneklemdeki etkisi 

araştırılabilir. 
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EKLER 
 

EK 1: Mobil Öğrenme Uygulaması Tablet Ekranı Görüntüleri 
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Öğrenci Giriş Ekranı 



64 

 

 
 

Kayıtlı Olunan Derslerin Seçimi 
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Öğrenme Yönetim Sistemi Menüleri 
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Duyuru Ekranı 
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Ders Bilgilendirme Blogu  



68 

 

 
 

ActionScript Kodları Sözlüğü 



69 

 

 
 

Mouse Olayları Dersi Konu Alt Başlıkları 
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EK 2: Mobil Öğrenmeye Yönelik Tutum Ölçeği 

 

Sevgili öğrenciler, 
Buölçek sizin mobil öğrenmeye yönelik tutumlarınızı belirlemek amacıyla 

geliştirilmiştir. Burada belirteceğiniz görüşler ve vereceğiniz bilgiler yalnızca araştırma 
amacıyla kullanılacaktır. Lütfen hiçbir maddeyi boş bırakmayınız ve her madde için tek bir 
yanıt veriniz. Çalışmaya yaptığınız katkılardan dolayı teşekkür ederim. 

 
Arş. Gör.Kadir DEMİR  

Doç. Dr.ErcanAKPINAR 
Bilgisayar ve Öğretim TeknolojileriEğitimiBölümü/ Dokuz EylülÜniversitesi 

 
 
 

 
 

1. Cinsiyetiniz nedir? 
   

[  ] Kadın   [  ] Erkek 
 

2. Sınıf düzeyiniz nedir? 
 

[  ] 1  [  ] 2  [  ] 3  [  ] 4 
 

3. Günlük ortalama internet kullanım süreniz nedir? 
 

[  ] Kullanmıyorum [  ] 1-3 saat  [  ] 4-6 saat [  ] 7 saat ve üstü 
 
 

4. Hangi mobil cihazlara sahipsiniz? 
 

[  ] Cep telefonu  [  ] Akıllı telefon  [  ] Tablet bilgisayar [  ] Oyun 
konsolu, netbook, notebook vb. 

 
 

5. Mobil cihazınız ile aşağıdaki işlemlerden hangilerini gerçekleştiriyorsunuz? (Birden 
fazla seçenek işaretleyebilirsiniz) 
 
[  ] İletişim kurma [  ] Dosya paylaşma [  ] E-kitap okuma [  ] Araştırma 

yapma 
 
[  ] Oyun oynama [  ] Video izleme  [  ] Müzik dinleme [  ] Alışveriş 

– Bankacılık işlemleri 
 
[  ] E-öğrenme  [  ] Podcast dinleme [  ] Diğer:………………….. 
 
 

 
6. Derslerinizi mobil öğrenme ile işlemek ister misiniz? 

 
[  ] Evet, sadece teorik derslerimde. 
 
[  ] Evet, sadece uygulama derslerimde. 
 
[  ] Evet, hem teorik hem uygulama derslerimde. 
 
[  ] Hayır. 
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 Mobilcihazlararacılığıyla      

1 …ders içeriklerine mekandan bağımsız olarak erişirim.      

2 …ders içeriklerine her zaman erişirim.      

3 …ödevlerimi daha kolay yaparım.      

4 
…ders hakkında arkadaşlarımla anında iletişim 

sağlarım. 
     

5 …ders çalışmak dikkatimi dağıtır.      

6 … ders materyaline erişmek kolaydır.      

 Mobil öğrenme      

7 … güncel bilgiye ulaşmamı sağlar.      

8 … zamandan tasarruf etmemi sağlar.      

9 …dersleri çevrimiçi olarak takip etmemi kolaylaştırır.      

10 … sayesinde bilgiye her an ulaşırım.      

 
11 

… sayesinde istediğim ortamda(ulaşım,ev vb. ) 

öğrenmemi sağlarım. 
     

12 … sosyal etkileşimi arttırır.      

13 … öğrendiğim bilgilerin kalıcı olmasını sağlar.      

14 … öğrenmemi kolaylaştırır.      

15 …derslere ilgimi arttırır.      

16 … dersi öğrenmem açısından yararlıdır.      

17 … derse ilişkin motivasyonumu arttırır.      

18 …derseilişkin merakımı arttırır.      

19 …keşfetme duygumu güdüler.      

       

20 
Mobil öğrenmeyi bütün derslerimde kullanmak 

isterim. 
     

21 
Bütün derslerim mobilöğrenme ile işlenirse 

öğrenmeye olan ilgim artar. 
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22 
Derslerimde mobil cihazları kullanacak yeterli bilgiye 

sahibim. 
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23 
Derslerimde mobil cihazları kullanmak beni mutlu 

eder. 
     

24 Mobil cihazlar geri bildirim almamı kolaylaştırır.      

 
25 

Mobil cihazlarda yeralan çokluortam 

özellikleriderse olan ilgimi arttırır. 
     

26 Mobil öğrenme uygulamaları dersin kalitesini arttırır.      

27 Mobil öğrenme teknik sorunlar yüzünden verimsizdir.      

28 
Mobil öğrenme internet bağlantısı sorunları yüzünden 

verimsizdir. 
     

29 
Mobil öğrenme derste öğrendiğim bilgileri 

pekiştirmemde yararlıdır. 
     

30 
Derslerin mobil öğrenme ile işlenmesi beni 

endişelendirir. 
     

31 Mobilcihazlarile grupçalışmaları dahaverimliolur.      

32 
Mobil cihazların farklı işletim sistemlerine sahip 

olması öğrenmeyi olumsuzetkiler. 
     

33 
Mobil öğrenmede kullanılan zenginleştirilmiş ders 

içerikleri derse ilgi duymamı sağlar. 
     

34 
Mobil öğrenme uygulamaları ile nasıl 

öğreneceğime kendim karar veririm. 
     

35 
Mobil cihazlar üzerinden bildirimler 

almak, derse karşı güdülenmemi sağlar. 
     

36 
Derslerimde mobil öğrenme desteği kullanılması beni 

kaygılandırır. 
     

37 
Mobil cihazları derslerimde kullanmak öğrenmem 

üzerinde kontrol sahibi olmamı sağlar. 
     

38 Mobil öğrenme yöntemi daha hızlı öğrenmemi sağlar.      

39 
Derslerimde mobil cihazların kullanılması 

kazanımlarımı arttırır. 
     

40 
Mobil cihazları derslerimde kullanırken zorluklar 

yaşarım. 
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41 
Mobil öğrenme ile işlenen derslerden daha çok verim 

alırım. 
     

42 Mobil cihazların derslerde kullanılmasını öneririm.      

43 
Derslerim mobil öğrenme ile işlenirse daha çok 

benimserim. 
     

44 
Mobil teknolojiler yardımıyla yapılan dersler ilgimi 

çeker. 
     

45 Derslerimde mobil cihazları kullanmak kolaydır.      
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EK 3: Akademik Başarı Testi 

 
Adı Soyadı: ………………………………………………………………  Şube: ( ) A   ( ) B 

Sevgili öğrenciler, Bu başarı testi sizlerin Eğitimde Grafik ve Canlandırma dersi ile ilgili bilgilerinizi ölçme 
amacıyla hazırlanmıştır. Yanlış cevaplarınız doğru cevaplarınızı etkilemeyecektir. Cevaplarınızı cevap 
anahtarına işaretleyiniz. Başarılar. 

Arş. Gör.Kadir DEMİR  
Doç. Dr.ErcanAKPINAR 

Bilgisayar ve Öğretim TeknolojileriEğitimiBölümü/ Dokuz EylülÜniversitesi 
 
 

1. Adobe Flash CS6’da oluşturabileceğiniz sembol türleri aşağıdaki seçeneklerden hangisinde 

doğru verilmiştir? 

 

a) Graphic, MovieClip ve Slider 

b) Text, Label ve List Item 

c) Checkbox, Radio Button ve Slider 

d) Graphic, MovieClip ve Button 

e) Graphic, Label ve Button 

 
 

2. Adobe Flash CS6’da kullanılan etkileşim, veri işleme ve daha fazlasına olanak sağlayan 

programlama dilinin adı nedir? 

 

a) Adobe Script 

b) Java 

c) Action Script 

d) PHP 

e) Java Script 

 
 

3. Adobe Flash CS6 çalışma alanına radyo butonu hangi panelden eklenir? 

 
a) Actions 

b) Tools 

c) Component 

d) Properties 

e) Swatches 
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4. Aşağıdaki kodlardan hangisi sahneye çift tıklanınca tanımlı fonksiyonu çalıştırmaya yarar? 

 
a) stageaddEventListener(MouseEvent. MOUSE_DOWN, kod); 

b) stageaddEventListener(MouseEvent. MOUSE _MOVE, kod); 

c) stageaddEventListener(MouseEvent. CLICK, kod); 

d) stageaddEventListener(MouseEvent. MOUSE _OUT, kod); 

e) stageaddEventListener(MouseEvent. DOUBLE _CLICK, kod); 

 

5. Bir nesneyi fare imleci ile basılı tuttuğumuzda sürüklemek için kullanılan yöntem 

aşağıdakilerden hangisidir? 

 
a) gotoAndStop(); 

b) startDrag(); 

c) hitTestObject (); 

d) Mouseshow (); 

e) Mousehide(); 

 
 

6. Bir nesnenin bir başka nesneye değip değmediğini kontrol etmek için aşağıdakilerden hangisi 

kullanılır?  

 
a) hitTestObject(); 

b) getChildIndex(); 

c) addChildAt(); 

d) swapChildren (); 

e) contains(); 

 
 

7. Adobe Flash CS6’da uygulamaların çalışması sırasında kullanıcı tarafından veri girilmesi 

amacıyla kullanılan metin biçimi aşağıdakilerden hangisinde doğru verilmiştir?  

 
a) Label 

b) Static Text 

c) Dynamic Text  

d) Text Area 

e) Input Text 
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8. Sahne üzerinde oluşturulan bir çizimi sembole dönüştürmek için aşağıdakilerden hangi yol 

kullanılır? 

 
a) Modify > Convert to Symbol 

b) Modify > Symbol 

c) Modify > Shape 

d) Modify > Transform 

e) Modify > Combine Objects 

 

9. Üç farklı boyut üzerinde nesne döndürülmesini sağlayan araç aşağıdakilerden hangisidir? 

 
a) Zoom Tool 

b) Free Transform Tool 

c) 3D Rotation Tool 

d) Gradient Transform Tool 

e) Eraser Tool 

 
10. Başlama noktası ile bitiş noktası arasında otomatik olarak şekil değiştirme animasyonu 

oluşturan Adobe Flash yöntemi aşağıdakilerden hangisidir? 

 
a) Motion Tween 

b) Classic Tween 

c) Shape Tween 

d) Draw Tween 

e) Layer Tween 

 
 
 

11. Birden fazla şekil ve nesneyi bir araya getirerek karmaşık şekiller oluşturmak için 

aşağıdakilerden hangi yol kullanılır? 

 
a) Modify > Arrange 

b) Modify > Transform 

c) Modify > Shape 

d) Modify > Combine objects 

e) Modify > Align 
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12. Sahnede seçilen nesneleri, yeni ve ayrı bir katmana dağıtmak için aşağıdakilerden hangi yol 

kullanılır? 

 
a) Modify > Timeline > Convert to Keyframes 

 
b) Modify > Timeline > Convert to Layers 

 
c) Modify > Timeline > Distribute to Layers 

 
d) Modify > Timeline > Distribute to Keyframes 

 
e) Modify > Timeline > Align 

 

13. Bir sahneden kopyalanan bir nesnenin, diğer bir sahnede aynı koordinatlara yapıştırılması 

için aşağıdakilerden hangi yol kullanılır? 

 
a) Edit > Copy 

b) Edit > Paste in Place 

c) Edit > Paste 

d) Edit > Paste in Center 

e) Edit > Paste Special 

 
 

14. Zaman çizelgesine anahtar kare eklemek için aşağıdakilerden hangi yol kullanılır? 

 
a) Insert > Timeline > Layer 

b) Insert > Timeline > Layer Folder 

c) Insert > Timeline > Frame 

d) Insert > Timeline > Keyframe 

e) Insert > Timeline > Blank Keyframe 

 
 

15. Oluşturulan hareketin ivmesini düzenlemek için aşağıdakilerden hangisi kullanılır? 

 
a) Properties > Tweening > Snap 

 
b) Properties > Tweening > Sync 

 
c) Properties > Tweening > Ease 

 
d) Properties > Tweening > Scale 

 
e) Properties > Tweening > Orient to path 
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16. Bir nesneyi düzgün, doğrusal, dikey ya da yatay bir şekilde tutup fare ile sürüklemek için aynı 

zamanda hangi tuşa basılı tutulmalıdır? 

 
a) Ctrl 

b) Shift 

c) Tab 

d) Alt 

e) Backspace 

 
17. Flash programında oluşturulabilecek tween (ara) türleri aşağıdakilerden hangisinde doğru 

verilmiştir? 

 
a) Motion tween, shape tween ve classic tween 

b) Shape tween, layer tween ve classic tween 

c) Draw tween, classic tween ve layer tween 

d) Layer tween, shape tween ve classic tween 

e) Motion tween, shape tween ve draw tween 

18. Oluşturulan hareketin yönünü saat yönünün aksine hareket ettirmek için aşağıdakilerden 

hangisi kullanılır? 

 
a) Properties > Tweening > Rotate > CW 

 
b) Properties > Tweening > Rotate > CCW 

 
c) Properties > Tweening > Rotate > AUTO 

 
f) Properties > Tweening > Ease 

 
g) Properties > Tweening > Orient to path 

 
 

19. Aşağıdakilerden hangisi Flash ortamında kullanılan ölçü birimlerinden değildir? 

 
a) Inch 

b) Point 

c) Centimeters 

d) Pixels 

e) Meters 
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20. Çizim ızgarasını sahnede nesnelerin üzerinde göstermek için aşağıdakilerden hangi yol 

kullanılır? 

 
a) View > Grid > Edit Grid > Show over objects 

b) View > Grid > Edit Grid > Show under objects 

c) Modify > Grid > Edit Grid > Show over objects 

d) Modify > Grid > Edit Grid > Objects 

e) Modify > Grid > Edit Grid > Show Objects 

 
 
 
 

21. Actions paneline aşağıdaki kısayollardan hangisi ile erişilebilmektedir? 

 

a) F9 

b) F6 

c) Alt + Tab 

d) F7 

e) F5 

 

22. Aşağıdakilerden hangisi Button sembol türünün düzenlenebilecek görünüm özelliklerinden 

birisi değildir? 

 

a) Up 

b) Over 

c) Down 

d) Under 

e) Hit 

 
 

23. Adobe Flash programı aşağıdaki dosya türlerinden hangisinde yayınlamamaktadır? 

 

a) JPEG 

b) GIF 

c) SWF  

d) HTML 

 
e) DOC 
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EK 4: Eğitimde Grafik ve Canlandırma Dersi Öğrenme Kazanımları 

 
1. Flash ile animasyon oluşturma mantığını açıklayabilme. 

2. Flash ın menülerini ve menülerin özelliklerini öğrenebilme. 

3. Flash programını kullanarak etkileşimli eğitim materyalleri hazırlayabilme. 

4. Movie clip, buton ve grafik arasındaki farkları açıklayabilme 

5. Çoklu ortam kullanarak eğitim yazılımı hazırlayabilme  
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EK 5: Animasyon Geliştirme Düzeyi Dereceli Puanlama Anahtarı 

 

Adı Soyadı:  

Numarası: 

PUAN 

3 2 1 

Araç kutusu panelini kullanabilme  
 

 
 

Belge özelliklerini ayarlayabilme    

Çalışma alanını düzenleyebilme    

Katmanları kullanabilme    

Grafikler ve metin seçmek, oluşturmak ve işlemek 

için Araçlar panelindeki araçları kullanabilme. 
   

Motion tween animasyon oluşturabilme    

Kare kare ve movie clip animasyon yapabilme    

Actionscript 3.0 ile fare ve klavye kontrolü sağlama    

Flash belgelerini yayımlama ve dışa aktarma    

Filtre ve renk ayarlarını düzenleyebilme    

Flash ortamında çizilmiş çizimleri kullanabilme    

Sesi içe aktarma ve kullanabilme    

Videoyu içe aktarma ve kullanabilme    

Animasyona maske ekleyebilme    
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EK 6: Mobil Öğrenmeye Yönelik Görüş Alma Formu 

 
1. Mobil öğrenmeye yönelik düşünceleriniz nelerdir? 

2. Mobil öğrenmenin eğitime ne gibi katkıları olabilir? 

3. Sizce mobil öğrenmenin olumlu yönleri nelerdir? 

4. Sizce mobil öğrenmenin olumsuz yönleri nelerdir? 

5. Derslerinizi mobil öğrenme ile işlemek ister misiniz? Sebebini açıklayınız. 

6. Öğretim elemanının, uygulama içeren bir dersi (Eğitimde Grafik ve Canlandırma 

dersi gibi)  mobil öğretim şeklinde işlemesi sizce uygun mudur? 

7. Gelecekte mobil öğrenmenin eğitimdeki yeri neresi olacaktır? 
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EK 7: Akademik Başarı Testinden Çıkartılan Maddeler 

 

 

Soru 

Numarası 

 Madde 

Güçlüğü 

Madde 

Ayırıcılık Gücü 

İndeksi 

1. Soru 0,82 0,28 

3. Soru 0,91 0,11 

4. Soru 0,55 0,28 

5. Soru 0,91 0,09 

7. Soru 0,30 0,15 

9. Soru 0,16 0,23 

10. Soru 0,46 0,24 

16. Soru 0,96 0,18 

21. Soru 0,21 0,07 

26. Soru 0,93 0,46 

28. Soru 0,52 0,27 

29. Soru 0,09 0,04 

30. Soru 0,05 -0,24 

32. Soru 0,15 0,20 

35. Soru 0,26 0,20 
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EK 8: Eğitimde Grafik ve Canlandırma Dersi Kazanımları İçin Belirtke Tablosu 
 

 

 

 

KAZANIMLAR 

BİLİŞSEL SÜREÇLER 
 

Bilgi Kavrama Uygulama Analiz Sentez Değerlendirme 

1. Flash ile animasyon 

oluşturma mantığını 

açıklayabilme. 

 

2, 9, 10, 

18, 19 
16     

2. Flash’ın menülerini 

ve menülerin 

özelliklerini 

öğrenebilme. 

8, 11, 12, 

13, 14, 20, 

21 

     

3. Flash programını 

kullanarak etkileşimli 

eğitim materyalleri 

hazırlayabilme. 

 

3, 17  4, 6    

4. Movie clip, buton ve 

grafik arasındaki farkları 

açıklayabilme 

 

1, 22      

5. Çoklu ortam 

kullanarak eğitim 

yazılımı hazırlayabilme 

5, 7, 15, 23      
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EK 9: Etik Kurulu Kararı (Geçerlik–Güvenirlik Çalışması İzni) 
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EK 10: Etik Kurulu Kararı (Uygulama İzni) 
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EK 11: Samsung Galaxy Tab 3 Teknik Özellikleri 

 

Ekran 

 TFT, 16 M Renk Derinliği 

 7 inç Boyutlu Ekran 

 1024 x 600 (WSVGA) Çözünürlük 

 LCD Ekran 

İşlemci 
 1,2 GHz İşlemci Hızı 

 Dual Core Uygulama İşlemcisi 

Bellek  8 GB  

İşletim 

Sistemi 
 Android 4. 1 Jelly Bean İşletim Sistemi 

Kamera 
 1,3 Megapiksel Kamera Çözünürlüğü (Ön) 

 3 Megapiksel Kamera Çözünürlüğü (Arka) 

Pil  4 000 mAh Pil 

Ağ 

 802.11a/b/g/n 2,4 + 5 GHz Desteği 

 A2DP, AVRCP, OPP, HID, PAN Desteği 

 DLNA mevcut 

Sensörler 

 Akselorometre 

 Jeomanyetik 

 Işık Sensörü Desteği 

Bağlantı 

 USB 2.0 desteği 

 3,5 mm Stereo Kulaklık Jakı mevcut 

 MicroSD (32 GB'a kadar) Harici Bellek Yuvası 

 Micro USB (5 V, 2 A) mevcut 
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Konumlandı

rma 

 GPS + GLONASS mevcut 

Ses ve Video 

 Video Biçimi: H.263, H.264, MPEG4, WMV, DivX 

 Tam HD (1080p) Video Oynatma mevcut 

 30 fps'ye kadar Video Kaydı 

 Ses Biçimi: AAC, AAC+, AMR-NB, AMR-WB, eAAC+, MP3, 

OGG, WAV, WMA, AC-3, FLAC 

Fiziksel 

Özellikler 

 111,1 x 188 x 9,9 mm Boyut 

 300 g Ağırlık 
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EK 12: Tablet Bilgisayarlara Ait MAC Adresleri 

 
Cihaz 

No 

Wi - Fi MAC Adresi Seri Numarası 

1 D8:90:E8:56:6F:EF RF1D958MP6J 

2 D8:90:E8:55:5C:CB RF1D957NBZL 

3 D8:90:E8:55:62:57 RF1D957P0GJ 

4 D8:90:E8:56:70:8D RF1D958MRKR 

5 D8:90:E8:55:63:59 RF1D957P4DK 

6 D8:90:E8:56:71:E1 RF1D958MXQY 

7 D8:90:E8:55:63:63 RF1D957P4JP 

8 D8:90:E8:56:68:B1 RF1D958LV3K 

9 D8:90:E8:55:60:B3 RF1D957NT4L 

10 D8:90:E8:56:6F:59 RF1D958MLXE 

11 D8:90:E8:56:6E:3B RF1D958MGKD 

12 D8:90:E8:56:69:AD RF1D958LYXA 

13 D8:90:E8:55:61:85 RF1D957NXAX 

14 D8:90:E8:56:6F:F3 RF1D958MP8X 

15 D8:90:E8:55:6F:E2 RF1D957NT3X 
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EK 13: Mobil Cihazlar için Geçerli Kullanım Sözleşmesi 

 

 
 

 
 



91 

 

EK 14: Üçüncü Faktör Analizi Sonuçları 

 

Maddeler 

Döndürülmüş Faktör 

 Yük Değerleri 

Madde- 

Test 

Toplam 
Korelasyon 

Değerleri 

Madde 

Ortak 

Faktör 
Varyansı 

Faktör 

1 

Faktör 

2 

Faktör 

3 

Faktör 

4 

49 - Derslerim mobil öğrenme ile işlenirse 

daha çok benimserim. 

0,82    0,67 0,70 

47 - Mobil öğrenme ile işlenen derslerden 

daha çok verim alırım. 

0,76    0,65 0,62 

51 - Mobil teknolojiler yardımıyla yapılan 

dersler ilgimi çeker. 

0,75    0,75 0,69 

48 - Mobil cihazların derslerde kullanılmasını 

öneririm. 

0,75    0,72 0,66 

24 - Bütün derslerim mobil öğrenme ile 

işlenirse öğrenmeye olan ilgim artar. 

0,71    0,61 0,62 

45 - Derslerimde mobil cihazların 

kullanılması kazanımlarımı arttırır. 

0,69    0,65 0,54 

26 - Derslerimde mobil cihazları kullanmak 

beni mutlu eder. 

0,67    0,70 0,56 

44 - Mobil öğrenme yöntemi daha hızlı 

öğrenmemi sağlar. 

0,69    0,67 0,56 

41 - Mobil cihazlarüzerinden bildirimler 

almak, derse karşı güdülenmemi sağlar. 

0,65    0,63 0,52 

23 - Mobil öğrenmeyi bütün derslerimde 

kullanmak isterim. 

0,65    0,65 0,50 

29 - Mobil öğrenme uygulamaları dersin 

kalitesini arttırır. 

0,63    0,68 0,53 

28 - Mobil cihazlarda yeralan çokluortam 

özellikleri derse olan ilgimi arttırır. 

0,60    0,69 0,53 

27 – Mobil cihazlar geri bildirim almamı 

kolaylaştırır. 

0,56    0,62 0,45 

52 - Derslerimde mobil cihazları kullanmak 

kolaydır. 

0,56    0,51 0,37 

43 - Mobil cihazları derslerimde 

kullanmaköğrenmem üzerinde kontrol sahibi 

olmamı sağlar. 

0,56    0,61 0,43 

39 – Mobil öğrenmede kullanılan 

zenginleştirilmiş ders içerikleri derse ilgi 

duymamı sağlar. 

0,55    0,64 0,46 

33 - Mobilöğrenmedersteöğrendiğim 

bilgileripekiştirmemdeyararlıdır. 

0,49    0,61 0,44 

40 - Mobil öğrenme uygulamaları ile nasıl 

öğreneceğime kendim karar veririm. 

0,45    0,56 0,35 

25 – Derslerimde mobil cihazları kullanacak 

yeterli bilgiye sahibim. 

0,44    0,40 0,24 
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35 – Mobil cihazlarile grup çalışmaları daha 

verimli olur. 

0,40    0,39 0,23 

8 - Mobil öğrenme güncel bilgiye ulaşmamı 

sağlar. 

 0,75   0,54 0,61 

11 - Mobil öğrenme sayesinde bilgiye heran 

ulaşırım. 

 0,73   0,57 0,62 

9 - Mobil öğrenme zamandantasarrufetmemi 

sağlar. 

 0,73   0,58 0,64 

12 - Mobil öğrenme sayesinde istediğim 

ortamda(ulaşım,ev vb.) öğrenmemi sağlarım. 

 0,72   0,62 0,66 

7 - Mobil cihazlar aracılığıyla ders 

materyaline erişmek kolaydır. 

 0,70   0,48 0,50 

5 - Mobil cihazlar aracılığıyla dershakkında 

arkadaşlarımla anında iletişim sağlarım. 

 0,68   0,36 0,44 

4 - Mobil cihazlar aracılığıyla ödevlerimi 

dahakolayyaparım. 

 0,57   0,53 0,42 

10 - Mobil öğrenme dersleri çevrimiçi olarak 

takip etmemi kolaylaştırır. 

 0,57   0,55 0,46 

1 - Mobil cihazlar aracılığıyla ders 

içeriklerine mekandan bağımsız olarak 

erişirim. 

 0,52   0,41 0,31 

 

 

2 - Mobil cihazlar aracılığıyla ders 

içeriklerine her zaman erişirim. 

 0,50   0,44 0,31 

14 - Mobil öğrenme sosyal etkileşimi arttırır.  0,41   0,49 0,31 

21 - Mobil öğrenme derse ilişkin merakımı 

arttırır. 

  0,75  0,56 0,62 

20 - Mobil öğrenme derse ilişkin 

motivasyonumu arttırır. 

  0,75  0,62 0,68 

18 - Mobil öğrenme derslere ilgimi arttırır.   0,74  0,57 0,65 

15 - Mobil öğrenme öğrendiğim bilgilerin 

kalıcı olmasını sağlar. 

  0,66  0,54 0,58 

19 - Mobil öğrenme dersi öğrenmem 

açısından yararlıdır. 

  0,58  0,66 0,61 

16 - Mobil öğrenme öğrenmemi kolaylaştırır.   0,57  0,69 0,65 

22 - Mobil öğrenme keşfetme duygumu 

güdüler. 

  0,54  0,57 0,46 

46 - Mobil cihazları derslerimde kullanırken 

zorluklar yaşarım. 

   0,72 0,33 0,54 

42 - Derslerimde mobil öğrenme desteği 

kullanılması benikaygılandırır. 

   0,69 0,31 0,51 

31 - Mobil öğrenme teknik sorunlar yüzünden 

verimsizdir. 

   0,68 0,29 0,47 

34 – Derslerin mobil öğrenme ile işlenmesi 

beni endişelendirir. 

   0,67 0,33 0,50 

32 - Mobil öğrenme internet bağlantısı 

sorunları yüzünden verimsizdir. 

   0,58 0,12 0,34 
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36 - Mobil cihazların farklı işletim 

sistemlerine sahip olması öğrenmeyi olumsuz 

etkiler. 

   0,57 0,17 0,34 

6 - Mobil cihazlar aracılığıyla ders çalışmak 

dikkatimidağıtır. 

   0,53 0,35 0,33 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


